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What’s New?
Version 1.5 of The Brain adds many new features to help you organize your information in
an even faster, more customizable way. The major additions are:

•Publishing which lets you publish Brains on the Internet. Site Brains make your Brain
available to any Brain user who wants to visit the web site you have Brain-Enabled™.
Guide Brains let you guide others through the web (see pg. 54).

•Spider Web Page which lets you map an entire web site in The Brain, creating a thought
of every page on a site in seconds (see pg. 57).

•E-mail Attachments no longer have to be dragged into The Brain separately from their
messages; both message and attachment can be dragged in together (pg. 54)

•Open without Activating which lets you open content attached to any thought without
activating that thought (pg. 12).

•Direct Web Access and Command Line Access which let you access web sites or
directory information by typing a URL or command line in the instant activation box (pg.
24).

•Printing which lets you print the plex in color and keep a visual hard copy of your thought
arrangements. (pg. 26).

•Plus countless interface improvements to help keep all of your information just a mouse
click away.
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1. Introduction
Welcome to The Brain™, the first software package that lets you use your computer the way
you use your mind – intuitively. The Brain’s easy-to-use visual interface integrates
information from the Internet and all your applications, allowing you the freedom to think
less about your computer and more about your work and interests. Your mind works in a
way that is unique to you, and The Brain lets you organize your information in the same
individual way, without limiting you to a pre-determined file structure.

The human mind is a container for a virtually limitless number of thoughts. The wonder of
the mind, and the source of human creativity, is the connectedness of all these thoughts.
Intelligence comes from the mind’s ability to think associatively – that is, to leap from
thought to thought, building webs of greater and greater complexity, until new ideas are
built. Associations are our inspirations.

The Brain uses a new concept, a data format called ‘thoughts’. Thoughts can contain any
type of information, including documents, spreadsheets, graphics, shortcuts, and web pages.
By letting you links and associate thoughts, The Brain expands to become a visual interface
that reflects the way you think.

With a simple click and drag interface you can create and navigate through networks of
thoughts in a conceptual space unique to your work habits. When you begin using The
Brain, you will find that your computer becomes easier to use – faster, more enjoyable, less
frustrating, and that your time is used more efficiently.

No more searching through files and folders, going to the Start menu, or scrolling through
long bookmark lists. There is no longer any reason to organize your information around
your computer’s generic storage systems. With The Brain, you organize your computer
around your information in the way that makes most sense to you, so you can concentrate
on content instead of its container.

How does The Brain accomplish this? By letting you create a simple, dynamic graphical map
in which to create and navigate all your information. Your Brain starts with a single thought,
to and from which several other thoughts can be visually linked. These thoughts have their
own links to other thoughts and, possibly, to each other. The Brain’s flexible structure
allows any thoughts to be linked, so that you are never more than a few steps from the
information you are seeking. Connections between thoughts are simple to make, and
reproduce the steps made in your mind.

Now that you’ve downloaded the software, you’re ready to begin downloading your brain
into your computer. 



2

2. Setup

System Requirements

The Brain will work on any computer running Windows 95, 98, or NT 4.0, or greater. We
recommend using a Pentium processor with at least 16Mb RAM, and having at least 4Mb of
space on your hard drive.

Installing The Brain

The Brain is simple to install. Installation will not change your computer’s configuration or
interfere with your existing files or operating system in any way.

From a CD-ROM 
4. Insert The Brain’s CD-ROM into the CD-ROM drive.

5. If your computer supports Autoplay, skip to step 3. Otherwise, click the Start button,
then select Run. Type D:Setup (where D: indicates the letter of your CD-ROM drive)
and press ENTER.

6. Follow the on-screen instructions to install the software. When setup is complete, The
Brain will run. 

From the Web
1. Double-click the file you downloaded, Brain.exe

2. Follow the on-screen instructions to install the software. When setup is complete, The
Brain will begin running. 

Purchasing The Brain

Your trial version of The Brain will expire after 30 days. When it expires, you will only be
allowed to create 100 additional thoughts without any change in The Brain.  Any thoughts
created after the 100 will prompt a message asking you to purchase The Brain. You will also
have limited Brain publishing space while using the trial version.

Purchasing The Brain will allow you:

• Unlimited use of your Brains.

• The ability to merge Brains.

• Enhanced technical support.

To purchase The Brain, click the Help menu and choose Purchase or call 310-656-8491
between 8am and 5pm Pacific Time, Monday through Friday.
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Getting Help

The Brain is equipped with a help system: 

1. Click the Help menu.

2. Choose Contents and Index.

Online Resources
Natrificial maintains an Online Tutorial, Online FAQ, and Online Reference at
http://www.thebrain.com. These resources can be accessed directly from the Help menu if
you have established an Internet connection.

E-Mail Technical Support
If you still have a question after checking our online resources, you can e-mail our Technical
Support department at support@natrificial.com.

Phone Technical Support
Registered users of The Brain may call Technical Support between 8am and 5pm, Pacific
Time, Monday through Friday. Click the Help menu and choose Technical Support for
more information.
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3. Getting Started
You’ve installed The Brain and there it is, sitting on your screen. What now? Let’s create a
Brain:

1. Click the Brain menu.

2. Choose New Brain.

3. When The Brain asks you to name your Brain, type your first name.

Congratulations! Your Brain is now sitting on the screen, awaiting information. Let’s go
through the steps you’ll use to begin loading your Brain with the ideas and knowledge you
have stored in your mind.

What You See On Screen

The Brain is a collection of connected thoughts. As you create and move between thoughts,
you will be navigating through the structure of your Brain. This is akin to scrolling through
folders but, as you’ll soon see, vastly more powerful.

A fully-developed Brain is too large to be viewed in its entirety. The visible area of a Brain is
called the ‘plex’, a collection of closely related thoughts. As you navigate between thoughts,
the plex updates to let you move easily within your Brain.
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Auto Hide Button

The Brain’s default setting is to hide when you begin working in another application. When
The Brain window disappears, it will be replaced by the auto hide button, which is
always on top of other windows. The auto hide button is an inconspicuous black
square with The Brain’s logo inside. When you need to display The Brain window,

click the auto hide button and the window will re-appear.

In Chapter 12, we’ll explore options for customizing your Brain, including how it displays
on your desktop.

If your web browser is at a Brain-Enabled™ web site, the name of the site will appear
beneath the auto hide button (see Chapter 9).

What Are Thoughts?

Thoughts are the basic building blocks of The Brain. A thought can represent virtually
anything: a concept, a project, a person, a subject, a document, a web page, a spreadsheet, a
file, a shortcut, a game, an application... whatever you can think of. You decide what
thoughts represent, what they are named, how they are related, and what they contain.
Because The Brain is not a hierarchical structure, no thought is more or less important than
any other – except when it becomes the active thought.
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The Active Thought
At the center of the plex is the ‘active thought’, currently Your Name. The active thought is
simply the thought to which you have most recently moved, the one you are thinking about
or working with at the moment. It is the thought of immediate interest. Thoughts closely
related to the active thought are displayed in different zones around it. We’ll look at the
zones shortly.

A thought is made active by clicking it when it is visible in the plex window. Try clicking the
thought Natrificial. It becomes the active thought and the plex regroups around it, showing
its close thoughts. Click Your Name again and it is activated. Other ways to activate thoughts
are discussed in Chapter 5.

Before we create thoughts, lets look at the relationships between thoughts. Relationships in
The Brain are made by creating child, parent, and jump thoughts of the active thought.
These terms don’t have anything to do with the type of information each can contain, but
simply describe their relationships to the active thought.

Parent Thought
A parent thought has at least one thought beneath it. You can think of parent thoughts as
representing different categories of information. In the plex, a parent thought is displayed in
the parent zone, above the active thought. 

Child Thought
It shouldn’t surprise you to learn that a child thought is a thought linked to a parent
thought. A parent thought can have numerous child thoughts. Child thoughts are displayed
below the active thought, in the child zone.

When a parent thought has more than one child thought, the child thoughts are considered
sibling thoughts of each other. Sibling thoughts are, thus, part of a group whose source or
subject is the same parent thought. The active thought’s sibling thoughts appear in the
sibling zone, to the right of the active thought. Let’s look at the relations of the active
thought Hobbies:

Jump Thought
Jump thoughts link different groups or families of thoughts. Jump thoughts are displayed in
the jump zone, to the left of the active thought.
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Gates
Thoughts are linked through a circle. Each thought in the plex has three circles. These
circles are called ‘gates’. Look at your new Brain – Your Name is linked to Natrificial through
a gate. 

Gates are hollow if there is no link through them to another thought, and solid if there is a
link to another thought. Gates can be used to create thoughts, link thoughts, or visually
remind you of the relationship between linked thoughts. We’ll use these methods to build
your Brain.

Above the active thought – in this case Stories – is the parent gate. The active thought is a
child thought of any thought linked through its parent gate. Below the active thought is the
child gate. The active thought is the parent thought of any thought linked through its child
gate. Beside the active thought is the jump gate. The active thought is a jump thought of any
thought linked through its jump gate.

Don’t worry if this seems like a lot of information. Let’s use a sample Brain to see how easy
it is to develop a Brain.

Sample Brain

The Brain comes with a sample Brain to demonstrate the power of links. Let’s take a quick
tour through Lou Green’s Brain. Lou is the editor of a Chicago Newspaper. Lou’s Brain is
available for you to explore. To open it:

1. Click the Help menu. 

2. Choose Contents and Index.

3. From the Contents page, choose ‘View and Navigate a Sample Brain’.

4. At the bottom of the opening screen, click ‘Open Lou’s Brain’.

Lou has organized his Brain into three main thoughts: Chicago News (his workplace), Family,
and Personal. These are child thoughts of the Lou Green thought. At the top of the plex
window is an area for ‘pins’. Pins are entry points to a Brain and stay in place regardless of
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where you are in your Brain. Lou has created pins to let him easily return to Lou Green (and
its three child thoughts), Advertisers, and Annette. Annette is a writer working on a big story
for the current issue. (For more information about pins, see Chapter 5.)

Below the plex is the ‘past thought list’. As the name suggests, this is a list of thoughts Lou
has recently navigated to. (For information on navigation, see Chapter 5). We can tell from
the past thought list that Lou has recently been thinking about his two favorite sports Hockey
and Golf. Let’s see how Lou has created links that will help him at work:

When Lou is thinking about the Stories thought, its siblings, Advertisers, On-line, and Writers,
are displayed. Notice that Current has, as parent thoughts, both Stories and On-line. This
arrangement lets Lou get to the stories in today’s issue from either Stories or On-line.
Additionally, the child thoughts of Current contain today’s stories, which are also linked to
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the writers that are child thoughts of Writers. (If a gate is filled, it leads to other thoughts; if a
gate is hollow, it does not lead to other thoughts.)

Big Crime, which represents the Big Crime story, links not only to its parent thoughts, the
writer Annette and the newspaper issue Current, but has, as child thoughts, various sources
and notes to back it up. Some of these sources are web pages.

Since Lou needs to keep in mind all the stories he’s working on, Big Crime’s siblings are
displayed in the sibling zone to the right of the active thought.

We’ve explored the big concepts behind The Brain. Wasn’t it easy? Now we’re ready to start
building your Brain.

Creating a Child Thought

In a new Brain, the first thoughts you create will likely be subject headings that are child
thoughts of the active thought. Currently, Your Name is the active thought. You can think of
it as the major subject heading of your Brain.

Let’s create a child thought:

1. Your Name is currently the active thought. Using your mouse, click Your Name’s child
gate (lower circle) and drag a line to any empty area beneath the active thought.

2. Now release the mouse button. 

3. A dialog box appears inviting you to create and name a child thought. A thought cannot
exist without a name. For our example, type the word ‘Work’.

4. Press ENTER or click the green check mark. 
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You have created a child thought called Work. Work is linked to its parent thought Your
Name. Now, let’s create a child thought in another way: 

1. Click the Thought menu above the plex window. (The Thought menu can also be
opened by right-clicking the active thought.)

2. Choose Create Child.

3. The same ‘Create Child’ dialog box appears. For our example, type the word ‘Fun’. 

4. Press ENTER or click the green check mark. 

Note that the new thought Fun appears in the child zone without you directing it there –
child thoughts automatically appear below their parent thought.

The plex should now look like this:

Creating a thought does not activate it. This stability of the plex lets you create relationships
without moving back and forth between thoughts. To activate a thought, click it.

Creating a Child Thought from a Child Thought
You can create a child thought even if its parent isn’t the active thought. Notice that the
thoughts you’ve created have gates. Let’s create a child thought from Work. (Of course, if
you’re not following our example, you can create a child thought from any child thought in
your Brain.)

1. While Work is in the child zone, drag downward from its child gate. 

2. For our example, call this new thought Order. 
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3. Press ENTER or click the green check mark.

When you create a thought from a non-active thought, the thought you link from becomes
the active thought. The Brain assumes that you are thinking about this thought and responds
automatically.

Creating Thought Content

Some thoughts, like Fun and Work, act as subject headings. You can think of such thoughts
as similar to (though more flexible than) file cabinets or folders. Thoughts created from such
thoughts will generally have content in the form of a file or a web page.

Let’s give a thought content: 

1. Activate the thought for which you want to create content. For our example, activate
Order, the thought you just created.

2. Click the active thought once more to open the thought.

Opening a thought that has no content displays the Select Content dialog box. This dialog
box should list all the applications on your computer that are capable of creating files. 

Normally, you would select your favorite word processing application to write a letter, but
we don’t know what application you use. One option that should appear, no matter what, is
‘Text Document’, created by Notepad. So, for the purpose of this example, we’ll use
Notepad to write our business letter.

3. Choose Text Document. Notepad will open and display a new document.

4. Type the following text into the document: ‘Dear Customer: This is to inform you that
we have received your order and will ship it immediately.’
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Now that we’ve written our letter, let’s save it and exit Notepad. To do so:

5. Click the X in the upper right of the Notepad window. Notepad will ask if you want to
save the file. Click Yes. The Brain gives the document a filename – one less thing for
you to worry about!

6. Look at the active thought. To the left of the word Order is an icon representing the
attached Notepad file. 

Remember – we used Notepad for this example because we’re relatively certain that if you
have Windows, you also have Notepad. In future, you’ll select the word processor or
application you want. The same steps will apply.

Opening Thought Content 

If you have attached a file or web page to a thought, clicking the thought when it is active
will automatically open the necessary application and load the file. You can also open the
active thought’s content by pressing ALT-ENTER.

A thought which has content will display the icon of the content’s type next to the name of
the thought. Because you no longer have to open an application and find a file, you no
longer need to create or remember filenames or folders – The Brain does that for you.

Open Without Activating

There will probably be times when you want to work on a thought’s content (file, shortcut
or web page), but don’t want to activate the thought and rearrange the plex. To open a
thought’s content without activating it, place your pointer on the desired thought’s icon
(located just left of the thought’s name). The icon will highlight. Clicking the highlighted
icon opens the content.

Creating a Thought with File Attached

As you use The Brain, you’ll no doubt want to attach an existing file to a thought. You can
do this by dragging the file from Windows to The Brain.

Drag File to Create Thought
1. Activate the thought you want the new thought and its file linked to.

2. Open Windows Explorer or My Computer. (You can also drag files from the desktop.)

3. Find the file you want to attach to the thought.

4. If The Brain is in auto hide mode, click the auto hide button to display The Brain
window or simply drag the file onto the button.

5. Drag the file to the plex. Do not drop the file yet. 

Notice that depending on which zone you drag the file over, a link extending from that
zone’s gate will form between the active thought and your pointer. 
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6. Drop the file into the desired zone. A new thought, named after the file, appears in that
zone and the file’s icon appears next to the new thought’s name.

Drag File to Thought
1. Create a child thought and name it in a way that will identify the file it will contain. An

appropriate name will indicate the content of the file and need have nothing to do with
the filename.

2. Activate the thought.

3. Open Windows Explorer or My Computer. (You can also drag files from the desktop.)

4. Find the file you want to attach to the active thought.

5. If The Brain is in auto hide mode, click the auto hide button to display The Brain
window or simply drag the file onto the button.

6. Drag the file directly onto the active thought until an icon appears next to your pointer. 

7. Drop the file. It will be attached to the active thought and its icon will appear to the left
of the thought’s name.

Drag Folder to Create Multiple Thoughts
If, prior to installing The Brain, you kept very organized folders, you may find it quick and
easy to move all the files in a particular folder into your Brain. In order to maintain the
power of The Brain, the folder should be fairly small and all the files in it should be related
in some way.

To drag a folder into your Brain:

1. Activate the thought you want the folder linked to.

2. Open Windows Explorer or My Computer. (You can also drag folders from the
desktop.)

3. Find the folder you want to bring into The Brain.

4. If The Brain is in auto hide mode, click the auto hide button to display The Brain
window or simply drag the folder onto the auto hide button.

5. Drag the folder from its Windows folder to the plex. Do not drop it yet. 

Notice that, depending on which zone you drag the folder over, a link extending from that
zone’s gate will form between the active thought and your pointer. 

6. Drop the folder into the desired zone. A new thought, named after the folder, appears
in that zone.

If you activate the new thought, you will see that it has a child thought for every file and
folder in the original folder.
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To import multiple folders, your Desktop folder, your Windows’ My Documents folder,
Explorer Favorites, or Netscape Bookmarks, click the Options menu and choose Import 
Folders. See Chapter 12 for details on this function.

Icons
The icon that appears next to a thought’s name indicates the type of content attached to the
thought. Most Windows’ applications have distinctive icons. If an icon has a small arrow in
the lower left, it is a shortcut to a file outside The Brain. The icon for a web page would be
that of your web browser. In version 1.5 of The Brain, the content of a non-active thought
can be opened by clicking its icon (see earlier in this chapter). In this screen shot, the active
thought contains a shortcut to a Microsoft Word document.

Different Types of Dragging
In the methods described above, dragging files created shortcuts in your Brain pointed to the
location of the file in its folder. Dragging didn’t actually move the file into the Brain. You can
tell that a shortcut has been created by the small arrow in the lower left of the icon (see above).

If you want to move the file itself into your Brain, you have two options: 

• If you hold down CTRL as you drop the file in the plex, you will leave the file in its
folder and make a copy in your Brain. This method uses the most disk space since
multiple copies of the file will exist. 

• To move the file out of its folder and into your Brain, hold down SHIFT while
dropping the file into the plex.

The same rules apply to folders you drag into your Brain.

Attach Shortcut to a Thought
We just covered creating a shortcut to a file by dragging a file onto a thought. You can also
attach a shortcut to the active thought by using the Select Content dialog box: 

1. Display the Select Content dialog box by activating and clicking a thought that doesn’t
have content.

2. Click the ‘Create Shortcut to File’ button. 

3. Find the file to which you want to point the shortcut.

4. Click OK.

The shortcut icon appears to the left of the thought’s name.
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Attach Web Page to a Thought
Web pages can be attached to thoughts in much the same way as files. A thought which has
a web page attached can be termed a ‘web thought’. When a web page is attached to a
thought, clicking the thought when it is active will open your web browser and display that
page. You will no longer have to keep separate, disorganized bookmarks.

Web pages can be attached in four ways: by dragging, by selecting content, by naming, and
by spidering (for information on spidering see Chapter 9).

By Dragging
1. Activate the thought you want to attach the web page to. For our Brain-in-progress,

activate Fun. If Fun is not visible in the plex window, navigate to it by retracing your
steps.

2. Open your web browser and go to a recreational web site, for example
http://www.desktoptoys.com

3. From one of Fun’s gates, drag a link to any web page. The web page’s title will become
the name of a new thought; the web page will be attached to that thought.

4. Once the page is attached, you can rename the thought to suit yourself (see Chapter 6).

OR

Repeat steps 1 and 2 

3. From the web site, drag the icon next to the URL to the active thought.

4. Once the icon is on the active thought, release it.

5. The icon will appear next to the active thought; the web page is now attached to that
thought. 

By Selecting Content
If you want to attach a web page to an existing thought: 

1. Activate that thought and click it to display the Select Content dialog box.

2. Click Attach Web Page.

3. If your browser is open, the current site is displayed in the Attach Web Page dialog box
and you will be asked whether you want to attach that web page to the active thought. If
your browser is closed or if you want to attach a different page, type the address of the
site you want to attach. In either case, your browser’s icon will appear to the left of the
active thought’s name.

By Naming
With or without your browser open, you can create a thought with a web page attached:

1. Drag from a gate or choose Create Thought from the Thought menu.

2. Name the thought after the address of the page you want to attach. 
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3. After you have created the thought, you can rename it without losing the web address
attached to it (see Chapter 6).

If you incorrectly type a URL, you can revise it (see Chapter 6) or detach it (see Chapter 7).

Using Jump Thoughts

There is no difference between the information that a jump thought can contain and the
information that a parent thought or child thought can contain. A jump thought is a
connection to a different group or family of thoughts. Activating a jump thought will move
you from the family of thoughts you’re working in and cause a significant reconfiguration of
the plex. Jump thoughts appear in the zone to the left of the active thought. Jump thoughts
can exist on their own or, as their name suggests, they can link far-flung groups of thoughts.

If a student of mathematics also runs a small business, the two families of thoughts are not
likely to be closely related. However, the student knows that when working on each thought
(Mathematics and Business) she’ll probably need to procrastinate, so she creates a jump
from each thought to a thought containing the Solitaire program.

Jump thoughts can also be used as a link to a thought that is related to the active thought
but not to its child thoughts. For example, a vending machine may have, as child thoughts,
the names of the candies it sells, but the thought for the machine itself might be linked by a
jump thought to an agency that counts and rolls quarters.

Using a Thought to Open an Application

If you need to open an application that creates files, you will usually do so by creating a
thought and choosing the appropriate application in the Select Content dialog box. But
applications that do not create files – such as games, e-mail applications, news readers – can
also be opened from The Brain. 

Program files install and work best if left as part of Windows, so they are not moved into
The Brain. Here are two methods of creating shortcuts to program files:

From the Desktop
If the application you want to add to your Brain has a shortcut on the desktop, drag the
shortcut into the plex, linking it to the desired gate of the active thought.

From the Start Menu
If there is not a shortcut on the desktop:

1. Use the right mouse button to click the Start menu on the Windows taskbar.

2. Choose Open to display a list of the programs installed on your computer. 

3. Find the Games folder and locate the shortcut to Solitaire. (With the Windows default
installation, this can be found by clicking Programs, then Accessories, then Games.)

4. Drag the Solitaire shortcut into the plex, linking it to the desired gate of the active
thought.

And That’s a Basic Brain!
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Congratulations! You have covered many basic concepts and built a small, simple Brain. As
you add thoughts, your Brain will evolve into an ever more useful tool, more reflective of
the way you think.

If you’ve followed along, the hard stuff is out of the way. Oh, it’s not as easy as that to build
a Brain – it’s easier. In the rest of this manual, we’ll look at some of the features and tools
that make navigating and working with The Brain even simpler and more effective.
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4. Establishing Thought Relationships
The only significant difference between categories of thought (child, parent, jump, sibling) is
where they are displayed in the plex. The categories describe the relationships of thoughts to
the active thought and to each other. All thoughts are directly or indirectly related to each
other by virtue of being in the same Brain. There are no rules governing the creation of
relationships between thoughts – whatever makes sense to you is the way your Brain ought
to be organized.

However, you might find the following examples will help you understand the variety of
relationships.

Imagine you own a company and you are reviewing personnel files. Each employee
has a file. You decide it makes sense to organize your employees by department.
Your personal Brain is called My Brain. From My Brain, you create a child thought
called My Company. My Brain becomes My Company’s parent thought. You create four
child thoughts from My Company – Manufacturing, Sales, Service, and Billing. These
departments are sibling thoughts of each other.
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Now you go to each department and create more child thoughts, one for each
employee of the department. If an employee splits time between two departments,
you can make him a child thought of both departments – he’ll appear in both
contexts and you won’t have to duplicate his file. In this example, Bob is a child
thought of both Manufacturing and Sales. This is one of the powerful features of The
Brain – having a thought under more than one heading.

If you own more than one company, but have one accountant for all of them, you
might want to create a thought called Accountant and link it as a jump thought to
each company. 

Imagine you’ve just completed a merger between My Other Company and one headed
by a competitor named Joe. Since you and Joe are now partners, Joe’s Company
becomes a parent of the merged company.
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Because Joe wants to avoid a conflict of interest, the merged company no longer
uses the same accountant. So its jump gate is hollow, while its sibling’s jump gate
maintains that link and is filled.

As you use The Brain, you will develop a sense of the type of relationship to make between
thoughts. It is always possible to change relationships. (see Chapter 6).

Families of Thoughts

It is tempting to view thought relationships as families, and indeed different parts of your
Brain are types of family, with their ancestry spread before you, represented by subjects and
categories. But unlike human families, a child thought can be a parent of a sibling and have
more than two parents.

The complex relationships you form in The Brain are the source of its power. Let’s consider
sibling thoughts that also share a parent-child relationship: 

Let’s say you are studying philosophy. You might have a parent thought called
Philosophy. Individual philosophers such as Plato and Aristotle could be child thoughts
of Philosophy. Each of these siblings, in turn, may have child thoughts. Aristotle was
a student of Plato, so you may want to make Aristotle not only a child of Philosophy,
but of Plato, so that when you’re working with Aristotle, Plato is only a thought away.

Notice that when Philosophy and Plato are in Aristotle’s parent zone, their relationship
(Philosophy a parent thought of Plato) is shown by the link from the child gate of Philosophy to
the parent gate of Plato. 
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Clearly, The Brain is a powerful way of organizing ideas and information. No hierarchical
file structure can provide as much cross-referenced information at a glance. And our
example is pretty basic – a fully-developed Brain can hold many more thoughts and much
more information.
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5. Navigating Your Brain
All thoughts are related – directly or indirectly – simply by being part of the same Brain.
Thoughts do not exist on their own. You can always navigate from one thought to another
by following links. Thoughts that seem to have nothing to do with each other are related
through a chain of links. Even, let’s say, the Queen of England and asparagus:

You have a thought called Queen of England. One of its child thoughts Prince of Wales
has a jump thought to the story of the Frog Prince. The Frog Prince, in turn, has a
parent thought called Fairy Tales. A sibling of Frog Prince is Jack and the Beanstalk
which has child thoughts called Giant and Jack. Giant has another parent thought
called Famous Giants which has a child thought called Jolly Green Giant. Jolly Green
Giant has child thoughts named after canned vegetable products, one of which is
Asparagus.

Depending on the relationship you create between them, thoughts may be closely or
distantly related. Thoughts are considered to be closely related when they are linked directly
or are siblings. Close thoughts of the active thought are displayed in the plex. Distant
thoughts of the active thought are not, although thoughts that are only one step (generation)
away from the active thought can be displayed. See Chapter 12 to learn how to display
distant thoughts.

As your Brain grows and becomes more complex, you can navigate more efficiently by using
pins, the past thought list, the instant activation box, the Search tool, and the History tool.

Pins

The top of the plex window, just below the menu bar, acts as a bulletin board onto which
you can place pins. Pins are entry points to a Brain. No matter where you are in the plex,
pins remain visible. In general, pins are created for frequently accessed thoughts. 

Remember Lou Green’s Brain and the way he used pins to move quickly to a few important
thoughts.

Simply click the desired pin and the plex will immediately reconfigure to activate that pin’s
thought.

All pins are shown at once – there is no list of pins to scroll through. If you have a lot of
pins, their names may not be fully displayed. You can move your mouse pointer along the
row and, as it moves from pin to pin, the current pin’s name will be enlarged and
highlighted. 

Creating Pins
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A pin can be created by dragging a thought in the plex or the past thought list (see next
section) and dropping it just below the menu bar. You can also create a pin of the active
thought by choosing Create Pin from the Thought menu.

Remember, when you drag a thought to create a pin, you are not moving the thought – you
are creating a reference to the thought.

Removing Pins
If you want to remove a pin, simply drag it into the menu bar or title bar.

Using Pins to Link Thoughts
Pins can also be used to create links between thoughts. (See Chapter 6 for details.)

 Past Thought List

You’ve probably heard the phrase ‘train of thought’. The past thought list is the visual
representation of that train – a scrollable list of thoughts in the order you activated them.
The past thought list is displayed at the bottom of the plex window and can be turned on
and off in the right corner by clicking the red triangle (on) or the blue X (off).

When the list is on, you can scroll through it by clicking the green arrows to the right and
left of the list. The most recently activated thought (the current active thought) is displayed
on the right of the list and is indicated by a red arrow to its left. As with pins, holding your
pointer over the name of a thought in the past thought list will enlarge and highlight the
name for easier reading. If a thought in the list has a file attached, the icon for the file’s
application appears to the left of the thought. Similarly, if a thought in the list has a web
page attached, the web browser’s icon appears to the left of the thought.

If you want to activate a thought in the past thought list, simply click it – the plex will
reconfigure to show that thought as the active thought, and the past thought list will update
to show it as the rightmost thought (current active thought).
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Even when the past thought list is not displayed, it tracks the order of thoughts made active
so that, when you turn it on, it is up to date.

Using Past Thought List to Link Thoughts
The past thought list can be used to link thoughts. See Chapter 6 for details.

Instant Activation Box

The instant activation box is a powerful feature that lets you activate a thought anywhere in
your Brain, whether or not the thought has a pin or appears in the past thought list. You can
even use the instant activation box to access a web page or open a directory, folder, or file.

Opening and Closing the Box
To open the instant activation box, press F2 on your keyboard, or ensure the past thought
list is displayed and click the rightmost thought (the active thought). You may have to scroll
right to reach the rightmost thought.

To close the box, click the red “X” in the upper right corner of the box or press ESC. The
plex will remain as is.

Activating a Thought
When the instant activation box is displayed, type the first few letters of the name of the
thought you want to activate; The Brain will show you various thoughts that match those
letters and complete the name of the closest match in the box. Click the green checkmark or
Press ENTER. The plex will reconfigure around the thought activated.

If you have more than one thought of the same name in your Brain, using the instant
activation box will activate the most recently created of these thoughts (see Chapter 6).
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Direct Web Access
Typing a URL address (for example: www.thebrain.com) in the instant activation box and
pressing ENTER will open the web page of your choice.

Command Line Access
Typing a command line (for example: c:\name of folder\name of file) in the instant activation
box and pressing ENTER will open the directory, folder or file of your choice.

Search and History Tools

You can use the Search and History tools (see Chapter 8) to display a list of thoughts which
meet specified criteria. Activate a thought in a Search or History list by clicking that
thought’s name.

Navigating from Keyboard

Another way to move from thought to thought is by using your keyboard. To enable
keyboard navigation, check ‘Allow Keyboard Navigation’ in Preferences.

Pressing ALT-ARROWS causes a red highlight to appear around the thought you have
moved to. To activate a highlighted thought, release the ALT key.
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To open a thought, click it or press ALT-ENTER.

And last but not least...

The Wiggle

That’s right, the Wiggle. The Wiggle is an extra navigating feature that helps you move
thoughts around the plex in one quick, simple step.  That step is accomplished by clicking
on a thought, dragging it over any thought which is not the active thought, and wiggling the
thought you are dragging back and forth.  The thought you were just wiggling over will now
become the active thought, and the plex will rearrange. Now you can move all around the
plex by just clicking on a thought and wiggling it over any thought you choose. This is
extremely helpful in moving a thought from one area of the plex to another area not
immediately visible.
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6. Expanding Your Brain
All thoughts in a Brain are linked directly or indirectly to each other. Links are the source of
The Brain’s power. Each Brain can hold over 65,000 thoughts. Any thought can have as
many as 128 child thoughts. Although only 72 child thoughts can displayed in the plex, the
rest can be accessed by scrolling. Each thought can link up to 32 jump thoughts and up to
32 parent thoughts. You can see how powerful this makes The Brain if you consider that in
Windows a folder can be related only to one other folder, and then in strict hierarchy.

As you’ve seen, the plex can display a great deal of information when thoughts are linked
associatively by context. In a well-developed Brain, the active thought will always be
surrounded by relevant information – its close thoughts and their content. Developing the
power of your Brain depends on the relationships you create between thoughts. In this
chapter, we’ll look at ways to create links and enhance the efficiency, and power of your
Brain.

Brain Menu

The Brain menu present several options:

• To create a new Brain, choose New Brain.

• To open an existing Brain, choose Open Brain.

• To rename a Brain, choose Rename Brain.

• To publish a Brain, choose Publish Brain on the Internet ...

• To view previously published Brains from Brain users everywhere, choose View
Published Brains.

• To print out an image of your plex window, choose Print Plex.
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• To see a list of Brains that have been used recently, choose Recent Brains.

• To load a Guide Brain, a map of part of the World Wide Web, choose Natrificial
Internet Guide.

When you choose New Brain, a dialog box appears, inviting you to name the new Brain.
You can give the Brain any name you like, but to avoid confusion with other Brains, we
suggest naming it as closely as possible after the name of the person who will be using it.
We suggest you create only one Brain for all your information, although you may want to
create several Brains for networking purposes (see Chapter 11).

Your new Brain’s storing location will be c:\My Brains by default. To change this location,
click Browse in the New Brain dialog box and select the storing location of your choosing.

Any Brain you create will automatically have a jump thought called Natrificial which can take
you to our online resources, should you need them. (If you want to delete this link, see the
method for doing so in Chapter 7.)

Thought Menu

The Thought menu is one of The Brain’s smartest features. When you open it, you will see a
list of options pertaining to the active thought. Depending on the status of the thought’s
content, this context-sensitive menu will change, offering only the options available – no
frustrating grayed options.
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For example, if a thought contains a file, the Thought menu will look like this: Instead of
viewing the Thought menu from the menu bar, you can display it by right-clicking any
thought, any pin, or any entry in the past thought list.

Thought Names

The essence of The Brain is simplicity. To make meaningful associations between thoughts,
you’ll probably want to keep their names as short and direct as possible. Also, the shorter a
thought’s name, the likelier it is to appear in the plex window in its entirety.

It is possible to create more than one thought with the same name. If you try to create a
thought whose name exists, The Brain will ask, if instead of creating a new thought with
that name, you want to link to the existing thought of that name. If you create a thought,
The Brain will distinguish these same-name thoughts (for purposes of instant activation or
establishing links by name) by selecting the same-name thought that was most recently
created, even though the thoughts may be in different relationships or have different content
or notes.

Renaming Thoughts

A thought’s name can be changed at any time. Using the Thought menu, choose Rename
Thought and give the thought a new name. You can also change a thought’s name in
Properties (see Chapter 8).

If you change the name of a thought, its pin and its name in the past thought list will also
change. The thought’s links, content, and notes will be unaffected.

Creating Thoughts

To review what was presented in Chapter 3, you can create a thought by:

• Dragging from a gate of a thought in the plex.

• Dragging a file or folder from Windows or the desktop into the plex. 
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• Using the Thought menu.

• Using keyboard commands to create a child thought (F10), a parent thought (F11), or a
jump thought (F12).

If The Brain window is not visible, dragging to create a thought is still possible via the auto
hide button, but the thought you want the new thought to link to must be the active
thought.

Using Auto Hide Button with Drag and Drop
When The Brain window disappears, it is replaced by the auto hide button, a small black
square with the blue Brain logo inside it. To attach a file to the active thought as child
thought, parent thought, or jump thought when The Brain window is not present:

1. Start Windows Explorer.

2. Drag the file to the auto hide button. Keep in mind the different types of dragging (see
Appendix A). When your mouse pointer touches the auto hide button, The Brain
window appears.

3. Continue to drag the file into the desired zone, or onto the active thought to attach the
file to the active thought. Notice that, as soon as your pointer moves into the plex
window, a link forms between the file and the active thought’s gate whose zone the
pointer is over. As you move the pointer around the active thought, the link will jump
from gate to gate.

4. Drop the file when it is linked to the gate you want, or when it is on the active thought. 

To make dragging and dropping easier, you can prevent The Brain window from
disappearing by turning off the auto hide function (see Chapter 12).

Creating Several Thoughts at Once
If you want to create several thoughts of the same relationship, you can create them
simultaneously. Drag from a gate as if creating a single thought and, when the Create
Thought dialog box appears, type the names of the thoughts you want to create, separating
each with a semi-colon.

Using Notes to Expand Your Brain

A thought may only be associated with one file, one web page, or one shortcut. However,
the Notes tool lets you add information to any thought in the form of text, pictures, sound,
and shortcuts. See Chapter 8 for details on the Notes tool.

Linking Thoughts

As has been said, links are power. Not only do links forge associations that group thoughts
conceptually, they allow information to be stored in and accessible from various thoughts.
There are several ways to link to a thought.

To Link to Thoughts in Plex
To link to a thought in the plex, drag from the desired gate of one thought to another
thought in the plex. 
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The thought you drag from does not have to be the active thought, but it must be closely
related to the active thought to have its gates displayed. If you drag from a non-active
thought to create a thought, the thought you drag from will be activated. If you drag a link to
connect from a non-active thought, the plex will not change.

You can drag a link from a close thought to a distant thought as long as you display distant
thoughts (see Chapter 12). Distant thoughts do not display gates, so links can only be
dragged to them, not from them.

To Link to Thoughts Not in Plex
You cannot link directly to a thought that is not displayed in the plex. But you can still link in
any of three ways. If the thought you can’t see in the plex has a pin or a name in the past
thought list, you can drag links to them, or you can link ‘by naming’:

Drag to Pin
You can link to a thought that is not visible in the plex if it has a pin. Simply drag from the
desired gate to the pin. Pins save time when linking thoughts. If you want to link a thought
to many thoughts, create a pin of the thought and link to that pin.

You cannot link from a pin to a thought because pins do not have gates. 

The relationship you establish by linking a thought to a pin is between the thoughts – if you
delete the pin, the link between the thoughts will remain.

Drag to Past Thought List
As with pins, you can link a thought in the plex to other thoughts by dragging a link from
the appropriate gate of the thought in the plex to one or more thoughts in the past thought
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list. You cannot link from the past thought list to another thought because the past thought
list does not display gates.

Link by Naming
You can also link to a thought by creating a thought with the name of the thought you want
to link to. Here’s how:

1. Create a thought by dragging or using the Thought menu.

2. The Create Thought dialog box appears. Check the ‘Link to existing thought of the
same name’ box.

3. Type the first few letters of the name of the thought you want to link to. As with the
instant activation box, The Brain will complete the name.

4. Press ENTER. 

If you didn’t check the box, The Brain will subsequently ask whether you want to link to the
existing thought or create a new thought of that name.
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Saving Thoughts
All information pertaining to your Brain itself is saved ‘on the fly’ as thoughts are activated.
There is never any need to save your Brain. However, you must manually save files created
with applications. You can do this in one of two ways:

• Choose the Save icon or Save menu entry in your application.

• Exit your application and select Yes when asked if you want to save changes. 

Do Not Use ‘Save As’
When you work on a file, you should not use its application’s Save As command to change
the name or location of the file. Doing so will make the thought unable to locate the file the
next time you want to access it. If you use Save As to copy a file, you will have to drag the
file back into your Brain and re-attach it to a thought. Instead, consider making a template
of a file to be used as the basis for other files (see Chapter 10), or use the Thought menu’s
Copy Thought function (see Chapter 7).
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Printing Files

If you want to print the file attached to the active thought:

1. Open the Thought menu.

2. Choose Print.

The Brain will open the application used to create the file and automatically tell the
application to print the file. If the thought’s content is a web page, you will need an Internet
connection so that the page may be downloaded for printing. The application will not
automatically close after printing.

You can also open a file’s application by activating a thought, clicking it; and choosing Print
from the application’s File menu. You would use this method if you require a specialized
print job, such as printing a specific page range.
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7. Editing Your Brain
Sometimes, as in your mind, information in your Brain needs to be ‘put on the back burner’.
As your use and understanding of certain thoughts and information evolves, you might find
that the relationship between thoughts needs to be adjusted or information that you had
considered unimportant is now valuable. The adjustments required are easily handled by
The Brain.

Changing Thought Relationships

Thoughts can have any relationship with each other, and the relationship can be changed at
any time. But two thoughts may only have one relationship with each other at a time. For
example, you can change a thought from a child thought to a jump thought; doing so
removes the link to the child gate.

To change a relationship:

• Drag the thought around the active thought. Notice the link move from gate to gate
depending on the zone dragged over.

•  Drag from a different gate. The plex will automatically reconfigure to show the thought
in its new zone.

Unlinking Thoughts

When you find that the relationship between thoughts is no longer relevant, you can unlink
the thoughts. As long as it has another link to the active thought, the thought you unlink
will remain in your Brain. When the only link to the active thought is severed you risk
‘forgetting’ the thought (see next section).
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If you want to unlink the only link between a thought and the active thought, but want to
link the thought to another thought, establish the new link before removing the old one.

The unlinking procedure is simple: 

1. Click the link between the thoughts you want unlinked. 

2. The Brain will ask if you intend to unlink the thoughts. Click Yes if you do.

If you unlink a thought that has at least one other link to the active thought, that thought
and all the thoughts related to it will remain in your Brain, but you will have to navigate to it
(them) via the remaining links. You can still activate the unlinked thought by using the
instant activation box or by clicking its name in the past thought list, or its pin if available.

Forgetting and Remembering Thoughts

When a thought is no longer of immediate use, you can ‘forget it’. Forgetting is not the same
as unlinking. When you forget a thought, it remains in your Brain with all its related
thoughts – it simply will not appear in the plex unless you have chosen to display forgotten
thoughts (see below). Forgotten thoughts can be ‘remembered’ when needed. You can think
of forgetting as a way of simplifying the plex. Forgetting does not affect a thought’s content.

How to Forget
To forget a thought, click its only link to the active thought.

If the thought you want to forget has no other link to the active thought, The Brain will ask
if you want to forget the thought and its relatives. If the thought has another link to the
active thought, the thought will not be forgotten, but merely unlinked from the active
thought (see previous section); its other links will remain.

When you unlink a thought’s only link to the active thought, that thought is forgotten.

When you forget a thought, you also forget thoughts related exclusively to it. If you click an
active thought’s only link to the rest of your Brain, The Brain will assume that you intend to
forget all thoughts except the active thought. If you risk forgetting all thoughts except the
active thought, The Brain will ask you to confirm this intent. To confirm, type the name of
the active thought and click OK.

When you forget a thought that has links to other thoughts, The Brain will tell you the
number of thoughts you risk forgetting.

If you want to forget a thought but not its relatives, instead of clicking the link, right-click
the thought and choose Forget Thought from the Thought menu. The Brain will forget the
thought and automatically link its relatives to another thought. The Brain makes an
intelligent guess as to which thought to link to. If no obvious choice is available, The Brain
will ask you to specify a thought.

Activating a Forgotten Thought
You might want to activate a forgotten thought. To do so use any of the following methods:

• Click its pin.
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• Click its name in the past thought list. 

• Use the instant activation box.

• Display forgotten thoughts and navigate to it. 

Activating a forgotten thought does not ‘remember it’; see below.

Displaying Forgotten Thoughts
Forgotten thoughts can be displayed. To toggle their display:

1. Click the Options menu.

2. Choose Forgotten Thoughts.

Forgotten thoughts are displayed in gray. Links to forgotten thoughts are displayed as
broken lines.

Regardless of whether forgotten thoughts are visible, the pin of a forgotten thought remains
visible, as does its name in the past thought list if the past thought is on. Clicking its pin or
its name in the past thought list will activate a forgotten thought and, indeed, display all
forgotten thoughts. Clicking a forgotten thought will not ‘remember the thought’.

You cannot create a thought from a forgotten thought or link forgotten thoughts to each
other.

How to Remember
If you need to bring a forgotten thought back to normal (regular use), you can ‘remember it’.
To remember a thought:

1. Display forgotten thoughts (see previous sub-section).

2. Link the forgotten thought to a thought that is not forgotten. You do not have to re-
establish the link that existed originally, but if you establish a new link, the original link
will also be re-established.

You can also remember a thought by using the link-by-naming method; see Chapter 6.

Deleting

Deleting Thoughts and Content
Deleting a thought eliminates it and its content (file or shortcut or web page) from The
Brain. You cannot remember a deleted thought. To delete a thought:

1. Forget the thought (see previous section).

2. Make sure forgotten thoughts are displayed (see previous section). 

3. Click the broken link between the thought to be deleted and the active thought.

4. Confirm that you want to delete the thought. 
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Another method works just as well:

1. Forget the thought (see previous section).

2. Make sure forgotten thoughts are displayed (see previous section).

3. Click the Thought menu.

4. Choose Delete Thought.

When you delete a thought that has links to other thoughts, The Brain will tell you the
number of thoughts you risk deleting. 

To delete a thought without forgetting it, hold down SHIFT as you click the link.

Deleting a thought permanently deletes any file attached to it. Deleting a thought with a
shortcut attached only deletes that shortcut – the original file will remain in its location.

Deleting multiple files or multiple thoughts can only be done by disconnecting the only link
between the thought and the active thought. You must take care when deleting thoughts. If
you delete an active thought’s only link to the rest of your Brain, The Brain will assume that
you intend to delete all thoughts except the active thought. If you risk deleting all thoughts
except the active thought, The Brain will ask you to confirm this intent. To confirm, type the
name of the active thought and click OK.

If you want to delete a thought but not its relatives, instead of clicking the broken link,
right-click the thought and choose Delete Thought from the Thought menu. The Brain will
delete the thought and automatically link its relatives to another thought. The Brain makes
an intelligent guess as to which thought to link to. If no obvious choice is available, The
Brain will ask you to specify a thought.

Deleting Content Only
If you want to delete the content (file or shortcut or web page) of a thought, but not the
host thought:

1. Click the Thought menu or display it by right-clicking the thought.

2. Choose Delete File, Delete Shortcut, or Detach Web Page; whichever applies. Only the
applicable option will appear in the context-sensitive Thought menu.

Undo/Redo

The Undo/Redo feature is accessed via the Options menu. Undo lets you step backward
through a virtually unlimited number of actions since your Brain was opened. However,
Undo will stop at the point you last deleted a thought or file, since there is no way to undo a
deletion.

Having used Undo to step backward, you can use Redo to step forward through past actions.
When you reach the most recently performed action, there will be nothing left to Redo and
the feature will be disabled until you use Undo again. If you perform an action while working
‘in the past’, Redo will be disabled and you will not be able to continue stepping forward.
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Moving Thoughts and Files

Thoughts
There will be times when you want to move thoughts relative to the active thought or to each
other. Thoughts are not moved as such; rather thought relationships are changed. There are
three ways to change a relationship between thoughts:

• Click and drag a thought to a different zone around the active thought.

• Unlink thoughts by clicking the link between them.

• Link from a different gate; for example to make a child thought a parent thought, link
from the child gate of the child to the current parent.

Files
Files can be moved into and out of your Brain. This is done by clicking the context-sensitive
Thought menu. 

If a thought contains a shortcut to a file in a folder outside your Brain, choose Move File into
Brain. The file will be deleted from the folder and the shortcut will be replaced by the file.

If a thought has a file attached and you want to move it to a folder outside your Brain, so
others can work on it:

1. Choose Move File out of Brain.

2. Select the folder to which the file is to be moved. 

When you move a file out of your Brain, the thought it was attached to will be associated
with the file by a shortcut. Clicking the thought, when it is active, will still open the file.

Copying Thoughts and Content

If you want to copy the active thought, choose Copy Thought from the Thought menu. The
copy will be linked as a child thought of the original and will be named ‘Copy of name of active
thought’. The thought’s content (file or shortcut or web page) will be copied as well.

Moving and Copying Brains

You may want to move your Brain from one drive to another or to another computer. You
may want to copy a Brain to back it up or create Brains based on it. Before you copy a Brain,
see Appendix A for background on how The Brain stores its files.

To move or copy a Brain:

1. Using Windows, go to the folder where the Brain you want to move or copy is stored. If
you accepted the default installation, this will be c:\My Brains

2. Click the .brn file whose filename is the name of the Brain you want to move or copy.

3. CTRL-click the _brn folder whose name matches the name of the Brain you want to
move or copy.
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4. Right-click to display the Windows’ Edit menu.

5. Choose Cut to move a Brain, or Copy to copy a Brain.

6. Navigate to the location you want to move or copy the Brain.

7. Choose Paste.

8. If desired, rename the new file and folder, taking care to give them identical names and
making sure that the file has a .brn extension and the folder a _brn. extension.

The new Brain will appear in the Open Brain dialog box, displayed from the Brain menu.

When a Brain is moved or copied from one computer to another, keep the following in mind:

• The .brn file may be too large to move or copy, necessitating transfer via serial cable
connection or removable disk drive.

• The second computer will require the applications used to create the files in its own _brn
folder.

• Shortcuts to files will not work unless the destination computer can access files on the
first computer.

Importing Brains

If you work with more than one Brain, you may, at some point, want to merge them. To do
this:

1. In Windows, find the .brn file of the Brain you want to import into the Brain that is open.

2. Drag the .brn file into the plex, creating the desired relationship with the active thought.

3. The Brain will ask if you want to import the Brain. Click Yes. Clicking No will create a
link from the open Brain to the Brain imported.

When you import one Brain into another, the active thought of the open Brain is linked to
the most recent active thought of the imported Brain.

You cannot cut and paste pieces of a Brain (a thought or group of thoughts) from one Brain
to another.
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8. Tools
Below the plex window is the tools window. It contains four tools: Notes, Properties, Search,
and History. Click the appropriate button to use the tool you want. 
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The order in which the buttons is displayed can be changed to suit your needs – simply drag
a button left or right. You can also drag the buttons to configure the tools window and allow
multiple tools to be displayed simultaneously.

If you have yet to register the Brain, there will be a Publish button in the far left side of the
tools title bar. Clicking it will display a dialog box letting you purchase the software – or, if
you have purchased the software, the button will help you register it. 

Also on the tools title bar you will find the Publish and Recent buttons. Clicking the Publish
button will open up the Publish Brain on the Internet dialog box, allowing you to publish
your Brain. Clicking the Recent button brings up a list of recently accessed Brains. Selecting a
Brain opens that Brain.

On the far right side of the tools title bar is a black button that will always display the name
of the Brain last accessed. Clicking this button will open the last accessed Brain.

Notes

Although a thought can only be associated with one file, one web page, or one shortcut, it
can hold a variety of information in its notes. The Notes tool, also known as Notes, is
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therefore extremely useful for annotating or expanding thought information. A thought’s 
notes exist in the Notes section. Notes are visible when the Notes button is selected.The
Notes tool is at once a simple word processor and a sophisticated one – a thought’s notes can
contain text that you type or copy, an object like a picture or a sound, a shortcut, or any
combination of these. 

Any application that supports Object Linking and Embedding (OLE) will let you drag and
drop into Notes. For example, if you see a picture on the Web that you’d like to include in
the notes of a particular thought, drag it into Notes. However, when dragging in a graphic
from the Web, there is one caveat: the graphic may not contain an address (hyperlink) – if it
does, only the address will appear in Notes, not the graphic.

If an application does not support OLE, you can copy and paste into Notes.

Importing Web Graphics From Netscape
An exception to the dragging procedure, described immediately above, involves the Netscape
browser which does not support OLE. To bring a web graphic into Notes from Netscape:

1. Right-click the graphic.

2. Choose Save Image.

3. Select a folder in which to save the graphic.

4. Drag the saved graphic from Windows into Notes.

Saving Notes
As with thoughts, a thought’s notes are saved automatically when you activate a new thought.
You do not need to manually save, although you can by:

1. Clicking the File menu.

2. Choosing Save.

You can save a thought’s notes as a separate file in any folder by: 

1. Clicking the File menu.

2. Choosing Save a Copy.
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3. Choosing a folder in which to save the thought’s notes.

4. Clicking OK. 

The thought’s notes will be saved in Rich Text Format (RTF), which is readable by any
recent word processing application compatible with Windows 95.

Adding More Content to a Thought
Good news! If you want to attach more than one file to a thought and didn’t think you could,
you’ll be happy to learn that you can create shortcuts to files (right click a file and select
Create Shortcut) and drag the icons from Windows Explorer or your desktop into Notes.
Clicking an icon in Notes will open its file.

Word Processor
If you use any word processing application more sophisticated than Notepad, you will have
no trouble using the Notes word processor. 

Features like font selection and size, bold, italics, underline, color (clicking the rightmost
down arrow displays a list of colors), justification, and even bullets are available on the
button bar at the top of Notes. The margins of a thought’s notes are limited to the width of
the tools window (see Chapter 12 to learn how to resize the window). Additional features can
be accessed by clicking the File menu or Edit menu.

File Menu
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Import File
Notes can import files that are saved in either of two formats, ASCII or RTF. If you want to
import a file into Notes, open it in the application used to create it and then save or export it
in Rich Text Format (RTF), which retains more formatting information and graphics than
ASCII. When you’ve done this, you can drag the file into Notes or choose Import from the
File menu.

If you only want part of a file to appear in Notes: 

1. Select the part you want and copy it. 

2. With your cursor in Notes, at the point you want the imported text to appear, click the
Edit menu.

3. Choose Paste to bring the text into Notes.

Save
You do not need to manually save a thought’s notes; they are saved automatically when
another thought is activated. However, in certain circumstances you may want to save
manually. For example, if a thought’s notes are long, you may want to save every now and
then to guard against losing information in the event of power failure.

After you have used Save, the function will be grayed in the File menu and unavailable until
you make changes in Notes.

Save a Copy
As mentioned, you can save a thought’s note as a separate file in any folder. To save a copy
of a thought’s notes:

1. Click the File menu.

2. Choose Save a Copy.

3. Choose a folder in which to save the thought’s notes.

4. Click OK. 

The thought’s notes will be saved in Rich Text Format (RTF), which is readable by any
recent word processing application compatible with Windows 95.

Print
To print a thought’s notes, choose Print from the File menu. 

Print Preview
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Print Preview lets you see how a thought’s notes will appear on the printed page. Several
views are available, and you can look at a thought’s notes page-by-page at several
magnifications.

You cannot edit text in Print Preview mode. To return to editing (normal) mode, use one of
these options:

• Click the Print button to send the thought’s notes to the printer.

• Click the Close button or press ESC to return without printing. Buttons do not wrap, so,
if the Notes section is too narrow to display all buttons, you will not be able to click
Close. Resize the tools window to display the Close button; see Chapter 12.

Print Setup
Selecting this option will display your printer’s name and information and permit access to its
properties. Other information in the Print Properties window includes paper size, source, and
orientation.

Page Setup
Selecting this option will display the page setup of a Notes object. In this window, you can
change page size, source, orientation and margin settings. 

Abandon Changes
Choose Abandon Changes to cancel changes you’ve made to a thought’s notes. If you have
manually saved a thought’s notes, this function will only cancel changes made since the
thought’s notes were saved. Activating a thought saves the notes of the outgoing thought.
Changes cannot be abandoned when you reactivate the thought.
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Edit Menu

Undo
When an operation has been performed and can be undone, the Undo option will appear at
the top of the Note’s Edit menu. 

Cut and Copy
Cut and Copy perform the same functions in Notes as they do in other applications. If you
have selected all or some of the text in Notes, choosing Cut will delete the selection and store
it in the clipboard. Choosing Copy leaves the original intact and stores the selection in the
clipboard. You can move parts of a thought’s notes into other applications by using the Cut
or Copy function of Notes and the Paste function of your application.

Paste
Paste moves information stored in the clipboard into Notes. This will let you move
information from one part of a thought’s notes to another part, or to another thought’s notes,
or to transfer information that has been cut or copied from an application into Notes and
vice versa.

Clear
The Clear function deletes information that has been selected; pressing DELETE will do the
same. Clear is different from Cut in that it does not store the information in the clipboard.
The only way to restore information removed by using Clear or DELETE is to choose Undo
(see above).

Select All
The Select All option selects all the information in a thought’s notes. Use this function, for
example, if you want to copy and paste the entire contents of a thought’s notes into an
application.

Find/Find Next/Replace
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These functions let you search for a specific word or phrase anywhere in a thought’s notes
and, if desired, change it to another word or phrase.

Insert Object
If you want to create or edit an object such as an image or a sound before bringing it into
Notes, use the Insert Object function. Choosing it displays a dialog box asking you to select
the type of object to create and giving you the option to create an object or create an object
from an existing file. You will also be able to check a box to instruct Notes to display the
object as an icon.

When you click OK, The Brain will open the application you selected. As you work on the
image, it will be displayed in Notes. When you are finished, simply close the application and
the image will be stored in Notes. Some applications open within Notes. 

Links
An object in Notes is normally a copy of the original object. When Links is selected, the
object becomes a reference to the original object. Now, changes made to the object within
Notes will be reflected in the original object and vice versa.

Object Properties
Displays the properties of the object within Notes as well as options for viewing that object
as editable information or as an icon.

Object
When you have inserted an object in Notes, choosing this option will let you open the object
(if only the icon is displayed) or edit the object with that object’s application menu.

Properties

The Properties tool provides information about the active thought and its content, if any.

This screenshot shows the properties of a thought called Writers which has a Microsoft Word
file called Writers.doc attached. You can rename the active thought by editing its name in
Properties. 
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If instead of a file, a web page were attached, Properties would display the page’s Universal
Resource Locator (URL).

Clicking the Details button provides information about the path and filename of the
thought’s content. This is helpful if you want to move the file out of your Brain. The Content
Details dialog box also lets you change the file or URL attached to the thought.

‘Created’ at the bottom of the Properties section shows when the thought was created.
‘Modified’ shows when the thought was last modified. ‘Active’ shows the amount of time
spent on the active thought, not just in the current session, but since its creation.

If no file or web page is attached to the active thought, the Select Content button will be
present. If you wish, click the button to display the Select Content dialog box and add
content to the thought. You can display the same dialog box by opening (activating and then
clicking) a thought that has no content.

You can assign keywords to any thought. These will be useful when using the Search tool to
look for or to group thoughts (see next section). If you use more than one keyword, separate
the keywords with a space.

In the Properties window, directly under Keywords, is the Private button. Clicking this
button brings up the Set Privacy Status dialog box, which enables you to make individual
thoughts available, or not available, when publishing a Brain (see Chapter 9 for details on
how to publish a Brain). 

At the top of the dialog box you will see the name of the active thought. This option will
only pertain to that specific thought. You can now select whether you want to make this
thought private when publishing (that is, not available for Brain users to see when accessing
your published Brain) by checking the Yes circle, or not private by checking the No circle.
You can also choose when you would like to make a thought private by checking the Before
or After circles and putting in a date. 

Search

The Search tool is a great way to find, group, and activate thoughts. The Search tool displays
an alphabetical list of thoughts organized by category. The default category ‘All Thoughts’
(sample shown in screenshot) displays every thought in your Brain. Other categories include: 
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Forgotten Thoughts; Parentless Thoughts; thoughts with Files, Web Pages, and Shortcuts
attached; Related Thoughts; Invalid Web Links and thoughts with particular file extensions.

To activate a thought from a Search list, click it.

To see other thought categories, click the down arrow to the right of the category box.

Parentless Thoughts
Parentless thoughts are thoughts without parents. In the Brain you created in Chapter 3, Your
Name and Natrificial were parentless thoughts. Parentless thoughts tend to be subject
headings or organizers.

Related Thoughts
This category produces a list of thoughts related to the active thought. The list lets you see
which thoughts are close to the active thought. The Related Thoughts list updates
automatically when you activate a thought.

On selecting this category, The Brain asks how many generations you would like to display.
Generations are counted from the active thought. The less generations you select, the more
closely the found thoughts will be related to the active thought. A large number of
generations may display every thought in your Brain.

Invalid Web Links
Choosing this category will allow The Brain to search and list web links which are no longer
valid.
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The Find Button
The Find button is located to the right of the Search drop down box. Click this button when
you want to find a specific thought or group of thoughts. Clicking Find... displays the Find
Thoughts dialog box, in which you can input criteria for performing a search. 

Some of the criteria are: thought name, keywords (assigned in Properties; see previous
section), a search through all Notes sections contained in a Brain and through all files
contained in a Brain. You can also use the drop down box located in the upper left hand
corner of the Find Thoughts dialog box to search with the help of thought history. Simply
choose whether you would like to search thoughts Accessed, Modified or Created and a
second dialog box will appear asking you to specify a time (for example, “in the last 2 days”).
You can also choose to ignore history and not use this drop down box. After you have
selected search criteria, The Brain will display the results in the search window. 

History

Selecting the History tool displays an alphabetical list of thoughts created, modified, or
activated within a selected time frame, along with a bar chart showing the relative length of
time the thoughts were active.

This function will help you see what you’ve been doing recently. It comes in handy if you are
interrupted and lose your train of thought. It’s a great aid to project managers who control
productivity, professionals whose billing is based on time, and to people who want to manage
their time and work more efficiently. For example, if a lawyer has assigned a thought to each
of his or her clients, a look at a History list will help when filling out time sheets for billing.
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On the other hand, a History list can also show how much time you have devoted to
Solitaire!

Click the Update button to refresh a History list.

To activate a thought from a History list, click it.

See the related ‘Count X Minutes of Idle Time As Active’ in Chapter 12.
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9. The Brain and the Internet
The Web is an amazing resource, offering information and entertainment of virtually all
types. Its power and value lies in its scope and variety. One of the most powerful and useful
features of the Web is the ability of pages to link with other, related pages, somewhat like the
way The Brain works with thoughts.

But where the Web is troublesome is the source of its greatness – links. Links appear as
underlined, colorful bits of text or images, and there is no way to know exactly where a link
will take you. The problem is one of presentation – the Web’s links are not represented in a
way that is visually recognizable and usable.

Web browsers have tried to relieve this navigational problem by creating bookmarks to help
you access frequently visited sites. But bookmarks are generally not organized, and if you
take the time and effort to organize them, the best you can do is organize them hierarchically.
Further, they are isolated within the browser, separate from related files. 

The Brain solves these problems in a way that requires you to pay not more, not the same,
but far less attention than you did before. Attaching a web page to a thought, that is creating
a web thought, is similar to creating a bookmark, but the pages are effortlessly organized in a
way that makes sense to you. Plus, they are visually represented alongside other thoughts you
may have on similar subjects. With The Brain, your travel itinerary is alongside pages about
the places you’re traveling to, which are alongside your calculator for converting money,
which is alongside your address book in which you keep friends’ addresses.

Note: If Check for Brain-Enabled™ Web Sites is activated (see Chapter 12), when
visiting a web site, the Brain will check with Natrificial’s Brain server to learn if that
site is Brain-Enabled™. If yes, a Site Brain will be available to navigate that site.
Checking for Brain-Enabled™ sites is done anonymously.  Natrificial cannot track
the web use of its users.

Searching Web

Courtesy of the Search Web function in the Options menu, The Brain has a convenient built-
in web search tool. Simply type a topic of interest and select a search engine – The Brain will
search the Web for pages meeting your specification.
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This makes searching the Web quicker and easier, since you won’t have to find on-site search
windows. And if one site doesn’t produce the information you want, choosing another site in
the menu launches a search, without you having to find a bookmark for another site or typing
a cumbersome URL.

If you would like to add a search engine to the list of those already provided, simply click the
Custom... button and open the Custom Search Engine dialog box.  Enter the name of the
search engine desired and type in that search engine’s URL address in the Search URL box. 
When entering the URL, be sure to follow the format of the example given.

Creating Thoughts with Web Pages Attached

Once you find the pages you want, you can easily create thoughts of them (web thoughts) by
dragging, as described in chapters 3 and 6. If the page you want to attach to a new thought is
currently on your browser, you can drag directly from any gate to the browser to create a
thought named after the page’s title.

You can create a thought of a web page even if The Brain is hidden by dragging the icon next
to the URL in your browser to the auto hide button.

You can also create a thought of a web page by dragging from a thought’s gate. When The
Brain asks you to name the thought, enter the URL. The web address will automatically be
attached to the thought so that you can rename the thought immediately.

Attaching a Web Page to a Thought
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To attach a web page to an existing thought which has no content:

1. Activate the thought.

2. Display the Select Content dialog box by clicking the active thought.

3. Click the Attach Web Page button in the Select Content dialog box. 

4. Enter the URL of the web page you want to attach.

Thoughts Containing E-Mail

If you use an e-mail application, The Brain can help you integrate the messages you want to
keep with other information on the same subject. You can devote a section of your Brain to
your favorite joke e-mails or store e-mail from your business partner with other information
relevant to your business. 

Creating Thoughts With E-Mail Messages
If you use a popular e-mail application, you will most likely be able to create a thought of an
e-mail message by dragging the message into the plex; the relationship of the new thought to
the active thought depends on the zone dragged to. The thought will be named according to
the Subject line of the message. The e-mail message will be easier to find in your Brain than
scrolling through a long list of mail saved in order of receipt.

When you have attached e-mail to thoughts, you may go back to your e-mail application and
delete the messages from the saved message list.

If your e-mail application does not support drag and drop, you can copy messages to Notes.
To open e-mail from your Brain, create a thought and attach a shortcut to the e-mail
application. 

Many popular online services, such as America Online, CompuServe, Prodigy, and The
Microsoft Network have mail readers built into their software. Since none of these supports
drag and drop, and since mail readers are not stand-alone applications, you cannot access e-
mail in these services from The Brain.

E-Mail Attachments
Attachments to e-mail messages can be dragged into The Brain along with the message.
There is no need to drag attachments in separately. E-mail saved in a thought retains any
Internet address information or hyperlinks contained in the message – letting you go directly
from the hyperlink to a web page. This is useful if you want to link the web page to the
message’s thought. 

Publishing Brains on the Internet

You can publish your Brain on the Internet and share it with the world! Your published Brain
may contain all your thoughts and links to web pages, and even your files and Notes section -
- if you so desire. Send the URL location of your published Brain to friends through e-mail.
Put the link on your web site. Anyone can look at your Brain. Don’t worry – if they don’t
have The Brain, they will be prompted to download it.

You can publish your (personal) Brain, a Site Brain or a Guide Brain. Site Brains and Guide
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Brains are discussed later in this chapter. The method for publishing a Brain is the same,
regardless of whether it is a personal, Site, or Guide Brain.

To Publish a Brain

1. Open the Brain you want to publish. Activate the thought you want others to start from.

2. Choose ‘Publish Brain on the Internet’ from the Brain menu and the ‘Publish Brain on
the Internet’ dialog box will appear (see illustration above).

3. You must provide a title and description of the Brain to be published. The title will
appear on the viewer’s screen as the name of the Brain. The description will be used on
the Natrificial Web Site.

4. You have the option of including your Notes section and/or attached Files (instead of
simply web pages) that you want published.  Check which options you would like to
include.

5. Enter your e-mail address in the ‘Your E-mail Address’ box. You will be e-mailed a link
to your Brain that you can attach to your home page or e-mail to friends. You must enter
your e-mail address or you will not be able to receive the link to your Brain.

6. You can also add in your friends’ e-mail addresses in the “Send to:” box and have The
Brain automatically send them your published Brain link.  These addresses can be
removed at any time by clicking the “Remove” button.  You do not have to add any
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names in this box in order to publish your Brain.

7. Once you have entered this information, click the Publish button.

8. After clicking the Publish button, your Brain will be uploaded to the Natrificial server. 

9. You will immediately be e-mailed a URL. This URL is a link to your published Brain
which you may post on Web sites or e-mail to friends. You will also receive a URL link
that will let you download the Natrificial Published Brain buttons which you can attach
to your link and post. (See Putting Your Brain on a Web site, below.) If you do not
receive this e-mail, you may have entered your e-mail address incorrectly.

10. To view your published Brain, click on the URL e-mailed to you.  This will open your
browser. You will then be asked if you would like to save this file (your published Brain)
to disk, or open it immediately. Saving to disk places your published Brain anywhere you
would like on your computer.  Opening it immediately opens your published Brain.

NOTE: Published Brains are viewed in read-only mode. Only the creator of the published 
Brain can modify it, all others can only view and navigate. 

Updating a Published Brain
To update a published Brain, first open the Brain you would like to update. The Brain will
only update a Brain that is open. Now select Publish Brain on the Internet from the Brain
menu and select the drop down box at the top of the ‘Publish Brain on the Internet’ dialog
box. Select the Brain you have opened from this drop down box. Make the desired changes
and press the Replace button. 

Removing a Published Brain
To remove a published Brain, simply select Publish Brain on the Internet from the Brain
menu and select the Brain you would like to remove from the drop down box at the top of
the ‘Publish Brain on the Internet’ dialog box. After you have selected the Brain, press the
Remove button. The Brain you want to remove does not have to be open in order to be
removed.

Putting Your Brain on a Web Site
Make your Brain a part of your Web site’s content! Once you’ve published your Brain, you
can put a link to your Brain on your web page. To do this, place one of the Published Brain
buttons on your web page and attach it to the URL of your Brain.

Natrificial e-mails you links to both the URL of your Published Brain and the URL of the
Published Brain button download page.  Simply go to the Published Brain button download
page, select a button of your choice (there are three: one for a personal Brain, one for a Site
Brain and one for a Guide Brain), download the desired button, and use your HTML editor
to link your published Brain’s URL to the button and attach it to your site. Now, when
someone who has The Brain software, clicks the button on your site, your published Brain
will open on their computer. If they don’t have The Brain software, they will be prompted to
download it. After download, they will be able to read your published Brain.
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Putting Your Brain in an E-mail Message
There are several ways to put a link to your Brain in an e-mail message. The easiest is to use
the Send To box located in the Publish Brain on the Internet dialog box. Just type in the e-
mail address (or addresses) where you want your published Brain sent into the Send To box
and click OK. Alternatively, you can copy the published Brain’s URL link that is sent to you
into a message and send it to whom you wish. When the recipient clicks the link, your
published Brain will open on their computer. If they don’t have The Brain software on their
computer, they will be prompted to download it.

 Site Brains

You can construct a Brain of a Web site that can be downloaded and used to navigate the
site. This type of Brain is called a Site Brain. Navigating a Site Brain lets you bypass
unwanted pages to reach the content you want. A Site Brain is like a TV remote control –
instead of waiting for each page to download, you can go directly to the desired page.

Creating a Site Brain
To create a Site Brain, create a Brain and then create a thought for each desired web page of
the site. You can do this manually (by using drag and drop to bring each page into the plex)
or by spidering.

Spidering a Web Site
To spider a web site:

1. Activate a thought which has a web page attached. This thought can be part of an
existing Brain or the first thought in a new Brain. You will not be able to spider if a web
thought (a thought with a web page attached) is not the active thought. Some web site
home pages automatically forward your browser from http://www.website.com to
http://www.website.com/contents.html. Thus, it is wise to let the home page completely
load before you attach it to a thought.

2. Choose Spider Web Page from the Thought menu. This will display the Spider Site
dialog box.

3. This dialog box will display the name of the web page and its URL address at the top.
You must now set spidering parameters by choosing how deep to map the site, whether
or not you want to select the links to add or have the spidering tool automatically do this
for you and how far to follow its links to other sites.
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Depth This sets the number of pages to be mapped from the starting location. Depth
can be from 1 to 10.

Select Links to Add Check this circle to manually add links to your Brain.  

Automatically Add Links Check this circle to have the spidering tool automatically add
links to your Brain. 

Add Redundant Check this box to have the spidering tool add links that return to
previous pages in the web site, for example ‘Home’ or ‘Back to Top’. This option will
only be available when Automatically Add Links is checked.

Add Non-Local Check this box to have the spidering tool add web pages that are not
local to the site being spidered, for example a link on a personal web site that takes you
to Yahoo’s home page. This option will only be available when Automatically Add Links
is checked.

Spider Non-Local Check this box and the spidering tool will map non-local web site
pages to the Depth set. 

4. Once settings are chosen, click Start. 

5. If you checked Automatically Add Links, continue on to step 6.  If you checked Select
Links to Add, the Select Links dialog box will appear.  
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In the Select Links dialog box you can select the individual links you would like to add
from three areas: Normal (individual links local to the site), Non-Local (individual links
not local to the site), and Redundant (links that return to previous pages in the site). You
can select individually within each area or click Select All to choose every link in that
area. When you have finished selecting links, click OK.  Depending on the number of
depths chosen, you will either finish the spidering process or move on to another Select
Links dialog box (each dialog box corresponds to a link’s depth).

6. You can quit the spidering process at any time by clicking the Done button. When the
spidering tool has finished mapping the web site, it will display the number of sites
spidered out of the total number of available links.  Unless you select every option
available (Add Non-Local, Add Redundant and select all possible links) the number of
sites spidered will be a smaller number than the total available.  

Your Site Brain has been created. You can edit it by adding and deleting links, as you
normally would.

Now, to make your Brain available to others, you can use the ‘Publish Brain on the Internet’
function, (described above).

Accessing a Site Brain
Site Brains can be accessed through links placed on web pages or in e-mail.

When a Site Brain is open, a second button will appear on the title bar of the tools window.
This button will bear the name of the Brain you were just working in, so you can return to it
quickly when you have finished with the Site Brain.
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Site Brains are read-only (as are all published Brains). Only the person who created it can edit
a Site Brain. Other users cannot add to them or delete from them; only use them for
navigational purposes.

Natrificial also publishes various Site Brains that will be available to all Brain users. If you
navigate to one of the web sites that Natrificial has Brain-Enabled™, a button will appear on
your screen (on the title bar of the tools window or the auto hide button, if auto hide is
active) indicating that a Site Brain is available. Click that button and the Site Brain will be
downloaded and opened.

Guide Brains

A Guide Brain, of which the Natrificial Internet Guide is an example, is a Brain about a
particular topic or interest. Unlike a Site Brain, the web pages of a Guide Brain are from
different sites. 

To create a Guide Brain, create a Brain and fill it with relevant content. When finished, use
the ‘Publish Brain on the Internet’ command, as described above. To share your Guide Brain
with others, e-mail them the link to your Guide Brain. You can also put a link to your Guide
Brain on a web page.

Natrificial Internet Guide
Want to see a Guide Brain in action? We’ve mapped parts of the Web into the Natrificial
Internet Guide Brain, which you can access from the Brain menu of your own Brain. The
Natrificial Internet Guide contains useful and interesting web sites, all in Brain format. You’ll
see all sorts of cool stuff arranged, in context, next to other cool stuff.
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10. The Brain and Your Applications
In regard to The Brain, there are two types of application: those that create files and those
that do not. The Brain is a great tool for managing both types.

For applications that create files, an advantage of The Brain is that it saves the time and
attention devoted to starting your application, finding the file you want to work on, loading
the file, etc. All these tasks are performed automatically when you click a thought that has a
file attached. This automation lets you concentrate on your ideas. Also, when you create a file
by choosing an application from the Select Content dialog box, you will not have to worry
about making up a filename or winding through a series of folders to find a location to save
the file.

For applications that don’t create files, such as a web browser, game, utility, CD player, you
can attach a shortcut to a thought that will start the application when you open the thought.
By grouping such applications under a parent thought, and creating a pin that will quickly
take you to them, you save the time you’d spend moving through the Start menu or hunting
for a shortcut.

Juggling Several Thoughts at Once

You may need to keep several thoughts open at the same time. This would be the case when
cutting and pasting between files. It’s easy to work on more than one thought at a time. If an
application is open and can handle more than one file at a time, you can:

• Drag thoughts from the plex into the application.

• Activate thoughts and open their files in their application by clicking the active
thought.

If you drag in a thought whose file is in use in that application, the results vary. For example:

• WordPerfect will accept the second instance of the file, but, like sharing files on a
LAN, the second instance will be read-only and you won’t be able to save changes
made to it. 

• Microsoft Word will ask if you want to revert to the saved copy of the file. If you
click Yes, you will lose changes made since you saved the file.

Keeping Versions of a File

Sometimes you will want to keep versions of a file. For example, if you are writing a report
that will go through several drafts, you may want to keep earlier drafts. The best way to work
with multiple versions (files) is:

1. Before you work on the next draft, click the Thought menu and choose Copy
Thought.

2. The thought is copied. Rename the thought (name the copy) to reflect the new draft.

3. Activate the new thought and click it.
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4. The file opens to let you edit.

Using Templates

You may work on a document that is very similar to other documents, such as a form letter.
The Brain makes such work easy by letting you select a basic file when you want to add
content to the active thought.

A template is a file that is used as the foundation for creating other files, for example, a blank
invoice form to which you add job and price information and save under its invoice number.

To create a template:

1. Create the basic file. Give it a name that will indicate the type of file to be created
from it, such as ‘Form Letter’ or ‘Invoice Template’.

2. Create a thought for which the template will be used.

3. Display the Select Content dialog box.

4. Click the Add Template button in the dialog box.

5. Find the file you want to use as a template.

Notice that the name of the template appears in the Select Content dialog box. It will remain
there and you will be able to select it when you need to create a file based on it. If you no
longer need the template, go to the Select Content dialog box and click Remove Template.

One of the most helpful ways The Brain works with templates is in naming the files created
from them. If you’ve worked with templates, you know that you risk modifying them and
forgetting to rename the new file before saving it, leaving you with the modified version as
your template. It’s a lot of work to go back and remove modifications to restore the original
template. Since The Brain names files for you, you will never experience this annoying
problem.
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11. The Brain and Networks
The Brain works particularly well in a network environment. Not only can you open your
Brain from any computer on the LAN (local area network), but you can share a Brain with
other users. The Brain eliminates the need to think about the network environment, and
enables the network to function more productively.

In a network environment, in addition to having your own Brain, you might want to create a
Brain for each project, department, or user. This way, other members of a team will only be
able to access files relevant to their project or department. To grant access privileges to
particular files, you will have to create separate Brains and, using network software, set access
privileges for the folder the Brains are in.

Project managers will be  interested in using the History tool. It will show how much time
has been spent working on any aspect of a project.

A Brain can be opened simultaneously by several users. However, only the first user to open
that Brain will be able to modify it.

You can share files with other users without sharing a Brain. For example, it is simple to
move a file from The Brain into a network folder for others to use. To do this:

1. Display the Thought menu.

2. Choose Move File out of Brain.

3. Select the destination folder.

4. Click Save.

If you want to give others access to a copy of a file, simply drag it from the plex and drop it
into Windows.

Multiple Brains on One Computer

You can create as many Brains as you like. For individual users, we recommend keeping all
thoughts in one Brain, under their name or chosen title so that all thoughts can be related to
each another. However, there are circumstances when it is desirable to create multiple Brains.

You might want to create a different Brain for projects that you want to isolate or pass to
others to assess. The ability to create multiple Brains is useful if you share your computer.
Each user can create a Brain to suit his or her needs and style of computing. 
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12. Customizing Your Brain
This chapter deals mainly with the way The Brain is displayed, both internally and in relation
to other applications. Each Brain has its own set of customizable preferences. When you
create a Brain, it is set to default preferences. When you open a Brain, you will
simultaneously be loading its preferences.

Window Menu

This menu lets you set the way The Brain is displayed.

Auto Hide
The default display setting is auto hide on. This means that when you click your pointer in
another application, The Brain window will conveniently disappear and be replaced by the
auto hide button, a small black square with The Brain logo inside. (The uses of the auto hide
button in relation to attaching files and web pages is discussed in Chapter 6.) Auto hide on
allows you the most desktop space for working in other applications, but only works when
The Brain window is docked. You can drag the auto hide button to any of the four edges of
the screen. (See Dock, below).

When auto hide is off, other applications will run next to The Brain window. Even when
maximized, they will only be displayed in the area not taken up by The Brain window. Since
The Brain window will never be out of sight, the auto hide button will not be displayed.

You may find auto hide off is useful as you make the transition to The Brain, but after you’ve
attached files to thoughts, you will most likely want to turn auto hide on to free screen space
for working with applications.

Always On Top
This entry is only available when the Brain window is floating, that is not docked. With this
entry, you can ensure that The Brain window is never out of sight. The window will always
be displayed on top of other applications.
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Dock
The Dock entries in the Window menu let you choose the edge of the screen to which The
Brain window is attached. Try each entry to see which suits you. The Brain window can also
be docked to a different edge of the screen by dragging the auto hide button to that edge.

Float
Selecting Float lets you move The Brain window anywhere on the screen and adjust both its
height and width (see Resizing, next). The auto hide button will not work when Float is
selected as The Brain window will always be open. The Brain may be hidden by an
application. If so, click its entry in the Windows taskbar.

When set to Float, The Brain window behaves like a typical window.

With The Brain window set to Float, you may also select Always on Top. If you do, The
Brain window will always be displayed, but you can change its location and size to
accommodate the display of other applications.
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Resizing

Brain Window
No matter what settings you select from the Window menu, The Brain window can be made
any size you like. However, with The Brain window docked, it will always take up the full
length or width of the screen, depending on whether it is docked left/right or top/bottom.
You will only be able to expand it in the direction opposite the docked edge. 

To resize The Brain window:

1. Move the pointer over the interior window border until the pointer changes to a
double arrow.

2. Click and drag the border of The Brain window to the desired size. You can drag it
all the way to the opposite end of the display if you like, but if you’ve set The Brain
window to Always On Top, you will not be able to see other applications.

When set to Float, a maximize button will appear near the top right corner of The Brain
window. If you want to adjust the size of The Brain window, drag any border or corner until
the window reaches the desired size. 

Plex Window and Tools Window
You can adjust the relative size and position of the plex window and tools window. If you
have a complex Brain and are displaying distant and forgotten thoughts, you may want to
make the plex window larger. On the other hand, if you work frequently with Notes, you may
want to make the tools window larger. Simply drag the splitter bar between the windows to
make them bigger/smaller. Double-click the splitter to switch the positions of the windows.

The splitter button is in the middle of the splitter. Clicking the splitter button changes the
orientation of the windows from the top/bottom to left/right. 

Plex
The scale of the plex and its thoughts can be changed by dragging the resizing circle. This is
the circle that surrounds the active thought (not the animated active thought indicator – see
Animation, below). Drag this circle in or out to resize the plex.
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 Experiment to arrive at a size that suits you. The plex can be resized at any time.

Options Menu

The Options menu can be displayed by clicking its entry on the menu bar or by right-clicking
any empty area of the plex. The Options menu contains many important settings:

Undo/Redo
As discussed in Chapter 7, you can step back and forth through actions using Undo and
Redo. This is a context-sensitive entry which identifies the action to be undone or redone.
Note that Undo ends at the last deletion of a file or thought.

Search Web
As discussed in Chapter 9, you can launch a Web search directly from The Brain by using
this feature, which can be set to use search engines such as Yahoo, Lycos, and Excite.

Wander
Just as many of your most creative moments stem from letting your mind wander, so can The
Brain be set to Wander. If you select this option, The Brain will randomly step through your
Brain, activating thoughts, reconfiguring the plex and, possibly, letting you see thought
associations you had not considered.

Import Folders
If you are happy with the organization of your folders, you can move their contents into your
Brain by:

1. Choosing the Import Folders entry.

2. In the Import Folders dialog box, add the folders you want to import.

3. Click OK.

The Brain will automatically create child thoughts named after the folders you have imported.
Their parent will be the active thought. Each ‘folder thought’ will have child thoughts named
after and containing each file in its folder
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See Appendix A for advice on importing folders into a Brain.

Desktop
Check this box to import all the files and shortcuts on your desktop. They will be stored in a
thought called Desktop.

My Documents
Check this box to import all the files and shortcuts in your Window’s My Documents folder.
They will be stored in a thought called My Documents.

Explorer Favorites
Since The Brain overrides Internet Explorer’s Favorites by letting you open a web page from
within The Brain, you can check this box to import your favorites. They will be stored in a
thought called Favorites.

Netscape Bookmarks
Since The Brain overrides Netscape Navigator’s Bookmarks by letting you open a web page
from within The Brain, you can check this box to import your bookmarks. They will be
stored in a thought called Netscape Navigator Bookmarks.

Forgotten Thoughts
This option toggles the display of forgotten thoughts in the plex. As discussed in Chapter 5,
forgotten thoughts must be visible in the plex to be deleted. If a forgotten thought is
activated by clicking its pin or its name in the past thought list, forgotten thoughts will
automatically be displayed. If you want to turn off their display, return to the Options menu
and choose Forgotten Thoughts.

Hide Links
When this option is selected, all links in your Brain will be hidden. All functions of  links will
remain the same, however (for example, clicking on links to forget and delete thoughts), they
just will not be seen.

Auto Open Web Pages
When you turn Auto Open Web Pages on, The Brain will open your web browser and load
the web page attached to any thought you activate that has a web page attached. In the
Preferences section (see immediately below), you can set a delay so that if you are merely
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‘stepping on’ a thought with web content on the way to another thought, The Brain will not
slow down to open the page before letting you move on.

Display Properties

You may customize the look of the plex window by choosing Display Properties from the
Options menu. There are two pages of Display Properties: General and Colors.

General
Siblings
Checking the Siblings box will set the plex to display the active thought’s siblings in the
sibling zone to the right of the active thought. If unchecked, siblings will not be displayed.

Distant Thoughts
Check this box if you want to display the active thought’s near distant thoughts, that is
thoughts one step (generation) removed from the active thought’s close thoughts. These
thoughts can be linked to, but not from, because their gates are not displayed. Near distant
thoughts may clutter the plex, even though they are displayed in small type compared to close
thoughts. You can move your mouse pointer over a near distant thought to highlight it and
make it larger. Of course, if you resize the plex, near distant thoughts will become larger or
smaller along with the rest of the thoughts in the plex.

Markers
One of three markers may appear to the right of a thought if this box is checked. A red ‘A’
indicates that the thought was active in the last 15 minutes. A yellow ‘C’ indicates that the
thought was created in the last 30 minutes. A yellow ‘M’ indicates that the thought was
modified in the last 30 minutes. Like using the History tool, markers is a great way to see
what you have been working on.

Font
This drop-down menu lets you select the typeface to be used to display thoughts in the plex
window. There is no setting for font size since that is adjusted by dragging the resizing circle.

Icons
Content icons are displayed next to thoughts that have files, web pages, or shortcuts attached.
The icons let you know which application created the content. In this drop-down menu, you
can select Normal or Small icons, or choose Hidden if you do not want icons to be displayed.
Even if you set Icons to Hidden, icons will appear in the Properties tool.

Order By
When this drop-down menu is set to Name, thoughts related to the active thought will
appear in their zones in alphabetical order. You can also order display according to duration
active (choose Time Active), when last active (choose Last Active) or, if you would like to
choose the order yourself, no display order (choose None).

Wallpaper
Just as you can select wallpaper for your Windows desktop, the background of the plex can
be changed to any wallpaper. If you want to select wallpaper, click the Enabled box and use
the Browse button to find the wallpaper file you want to use. Depending on the wallpaper
you choose, you may want to check the Fill Thought Background box, which will put a solid
background behind the name of each thought to make it easier to read.

Reset to Defaults...
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If you click this button, all the settings in Display Properties will be reset to their default.
This will not affect options selected in other menus.

Colors
You can customize the look of The Brain by selecting a custom color for every element of
The Brain window. For example, the color of the resizing circle, thought names and
background can all be changed to suit your sense of style. Color schemes can be saved by
clicking Save in the Colors selection window and selecting a location. Color schemes can be
loaded into any Brain by clicking Load in the Colors selection window and choosing a color
scheme.

Preferences 

You may make more custom settings by choosing Preferences from the Options menu. There
are three pages of Preferences: General, Animation, and Servers.

General

Allow Keyboard Navigation
Checking this box allows the use of the ALT key and the Up, Down, Left and Right Arrow
keys in cycling through thoughts in the plex. (See ‘Navigating from Keyboard’, Chapter 5.)

Automatically Reorganize Dropped Folders
Checking this box lets you group same-name files under one thought.  When this box is not
checked, all imported files will be placed within the main folder thought without grouping.

Check for Brain-Enabled™ Web Sites
Checking this box lets The Brain request URL locations from your browser to locate Brain-
Enabled™ web sites. At the present time, Natrificial is not offering this service and the
default setting for this feature is not checked (activated). Companies that wish to offer
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additional information about web sites to their users can use this feature in combination with
the Paraweb server (a business oriented server kit to be released at a later date).

Note: If Check for Brain-Enabled™ Web Sites is activated (see Chapter 12), when
visiting a web site, the Brain will check with Natrificial’s Brain server to learn if that
site is Brain-Enabled™. If yes, a Site Brain will be available to navigate that site.
Checking for Brain-Enabled™ sites is done anonymously. Natrificial cannot track
the web use of its users.

Maximize Program Windows
You can have multiple programs running at the same time as The Brain. If you check this
option, The Brain will open them with their windows maximized. If The Brain window is
docked, the windows of other programs will not cover it. If it is floating, other programs will
completely cover it, unless Always On Top has been chosen from the Window menu. 

Open The Brain on Startup
Selecting this option will open The Brain every time you start Windows.

Stop Pointer Flashing
Some older computers cause the pointer to flash in the plex window. Check this box to stop
the flashing. If you select this option, your pointer may respond more slowly.

Count X Minutes of Idle Time as Active
Use this function to set the amount of time The Brain should consider a thought active
despite being unable to detect mouse or keyboard activity. This setting affects the accuracy of
the History tool and the Order By option, as well as turning off animation after the timer
runs out. For greater accuracy, a shorter period of idle time should be considered active. Such
accuracy is important if you are using the History tool for billing or project management.

Reset to Defaults...
If you click this button, all the settings in Preferences will be reset to their default. This will
not affect options selected in other menus.

Animation
Thought Movement
When Thought Movement is enabled, the change from one active thought to another is
animated. The speed of animation is set by using the slide bar.

Auto Open Circle
If you select Auto Open Web Pages in the Options menu, you will be able to use its slide bar
to set the delay between a thought’s activation and the opening of its attached web page. The
delay can be set from one to ten seconds. You should base delay on the speed you navigate
the plex, since you don’t want The Brain to pause while it opens the web page of a thought
you are only ‘stepping on’ on your way to another thought.

Active Thought Indicator
The active thought appears in the center of the plex. Immediately around it is the plex’s
resizing circle. Outside that is the active thought indicator whose presence and movement
can be regulated.
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Use the indicator’s slide bar to set the speed of its rotation. You can change the indicator’s
motion from clockwise to random clockwise-counterclockwise. Disabling the active thought
indicator removes it from the plex. The active thought will still be distinguished by the re-
sizing circle as well as its central position in the plex.

Servers
Information on server connections are listed here.  The location of the servers used to
publish and to access Site Brains are listed as well as the port numbers used to exchange data.
A space is also available for your e-mail address. The address listed will be the one used to
send and receive publishing information.
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Appendix A - Transition to The Brain
The Brain models itself on the unique, complex, multi-dimensional mind of the user. Other
interfaces that claim to enhance the Windows system of file organization are limited to
making Windows simpler or prettier or easier, but they all share the Windows hierarchical
organizational structure.

As you use The Brain, you will go for long periods without thinking about – or even seeing –
Windows. However, The Brain is not an operating system and so cannot replace Windows
entirely. You will find yourself interacting with Windows from time to time, particularly when
you begin using The Brain and move existing files and shortcuts into thoughts. Also, when
you install applications or upgrade existing ones, you will have to use the Windows’
installation process. 

Once you’ve become familiar with The Brain, you won’t miss Windows. The Brain is much
easier to use and vastly more powerful. The Brain and Windows both serve your file
management needs. They visually present the files on your hard drive and you use both to
access files you’ve created. 

But The Brain’s starts where Windows leaves off. By doing away with the hierarchical
structure imposed by Windows and organizing your information associatively, The Brain
makes it far easier for you to find and work on the files you need. Because the files are no
longer organized from the top down by application, but by your own sense of what content
belongs with what other content, The Brain breaks down the barriers between applications,
files on your hard drive, and pages on the Internet. Content is content, information is
information, thoughts are thoughts, and it is you, the user, that knows best how to piece
them together.

Using Windows to Move Files into The Brain

As discussed, when you want to associate a thought with an existing file (a file you created
before you used The Brain), you will need to use Windows Explorer, My Computer, or the
desktop to drag the file into the plex. There are three ways to drag files into the plex. Each
way has implications for hard disk space.

Dragging (creating shortcuts)
Simply dragging a file from Windows into the plex will attach to the thought, not the file
itself, but a shortcut pointed to the file in its folder. You would use this method, for example,
if you were sharing a computer with someone who needs to work on the same file as you do.
The important thing to remember about shortcuts is that if you or another user changes the
file name or location of the file, the shortcut may no longer point to the file, and your Brain
will not be able to open it. Discourage other users from changing file names.

CTRL-dragging (copying files)
CTRL-dragging copies the file and moves the copy into your Brain. There are two things to
consider with this method. First, while other users will still be able to work on the original
file, you will be working on a copy – changes you make will not be available to other users,
nor will their changes be available to you. Second, this method causes a file to take up twice
the hard disk space. You should only use this method if you want to create a copy of the file.

SHIFT-dragging (moving files)
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SHIFT-dragging moves the file into The Brain (see the next section for information on how
The Brain stores files). No copy will exist in the file’s original folder. Consequently, no other
users will have access to the file, unless they import it from your Brain (see Chapter 7). This
method uses the least space on your hard disk.

How The Brain Stores Files

If you accept The Brain’s default installation location, the program will be located in
C:\Program Files\The Brain. The file for each Brain created on your computer is stored in
C:\My Brains. Files containing Brain data (Brain files) have a .brn extension. The size of a
Brain file depends on how many thoughts it contains; each thought requires 2KB of space.
Brain files are named Brain Name.brn, where Brain Name is the name you’ve given to a Brain.
You will need to know the name of a Brain file if you want to import that Brain into the
Brain that is open, that is merge Brains (see Chapter 7).

The files you attach to thoughts in each Brain are stored in a folder named after the particular
Brain and with the extension _brn. So, files attached to thoughts in a Brain called Lou Green,
will be stored in the folder Lou Green_brn. You will need to access your My Brains folder if
you want to move a file from The Brain to Windows.

Advice for the Transition

The best way to make the transition to The Brain is on a file-by-file basis. However, for users
who had highly organized hard drives before installing The Brain, there is a quick and
convenient method of importing files into a Brain (see Import  Folders, Chapter 12).

Importing numerous files at once will turn your Brain into a highly efficient version of
Windows Explorer, but will reduce the power of your Brain to make the transition
effectively. Effective transition is achieved by associating thoughts ‘as you go’. If you import
folders, it is best if these folders contain a few files related to a specific subject. In this way,
the resulting Brain will be reasonably well organized, although you will have to manually
create relationships between thoughts to realize your Brain’s potential.

Avoid the temptation to move folders containing numerous files into your Brain. The Brain
can do this – it will take all the files you drag in and make them child thoughts of the thought
to which you drag them. These child thoughts will be named after the file attached to them,
so they will not be organized conceptually the way they would be if you had moved the files
into your Brain as you needed them. With the wholesale approach, your Brain will be
cluttered with thoughts you may not need; creating the proper links between relevant
thoughts could become a chore. 

Moving files within your Brain is not as straightforward as in Windows. You can move files
by dragging thoughts around the active thought or relinking thoughts, but on a large scale
this can be tedious. Your first instinct as to where to place a thought is usually best and most
easily remembered. The Brain is designed to accommodate this intuitive philosophy. Your
Brain will evolve as links between thoughts grow more numerous and complex – a process
that cannot be done quickly or haphazardly without sacrificing your Brain’s intelligence.

By making the transition on a file-by-file basis, the files that do not enter your Brain are
probably ones you never need, and every piece of information in your Brain will be useful.
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Appendix B - Keyboard Commands

Help

F1 Opens the ‘Contents and Index’ section of the Help menu 

Navigating

You can use ALT-arrow keys to navigate the plex. A red highlight around the thought
indicates the position of the ‘pointer’. Releasing ALT activates the highlighted thought.

ALT-ENTER Opens the content of the active thought.

F2 Opens the instant activation box

Creating Thoughts

These commands let you create thoughts related to the active thought:

F10 Child thought

F11 Parent thought

F12 Jump thought

Notes

These commands work in Notes:

CTRL-S Save

CTRL-P Print

CTRL-X Cut

CTRL-C Copy

CTRL-V Paste

DEL Clear

CTRL-A Select All

CTRL-F Find/Find Next

CTRL-H Replace

CTRL-Z Undo

Internet

F3 Web search
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Appendix C - The Illustrated Brain
This screenshot of The Brain window is based on Lou Green’s Brain (see Chapter 3).

This screenshot illustrates the use of auto hide when The Brain is docked, that is secured to
an edge of the screen.
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Appendix D - Troubleshooting
Here are solutions/explanations to some common problems:

Problem Solution / Explanation

I can’t find the top or
center of my Brain.

A Brain does not have a top or center. A Brain is not organized by
space, hierarchy, or time, but by thought association.

I can access all my
thoughts, but I can’t
create new ones or
attach new files to
existing thoughts.

Are you using a registered copy of The Brain? The demonstration
copy you downloaded from our web site will let you add to The
Brain for 30 days. After 30 days, you can access thoughts and
content, but to continue building your Brain you must register your
software. To register, click the Purchase button in the upper right
of the tools window.

I can’t drag objects
from Netscape.

Netscape does not support OLE. You will be more successful
using another browser, such as Microsoft Internet Explorer.

I can’t drag files from
the Open File dialog
box of my application
to a thought.

Applications that support drag and drop from Open File will let
you drag a file to a thought. If your application does not support
drag and drop from Open File, you will have to drag the file to the
thought from the desktop, Windows Explorer, or My Computer. 

Can I change the order
in which thoughts are
arranged?

Not on a thought-by-thought basis, but you do can display
thoughts by name, by the amount of time they have been active, by
the order in which they were activated, or in no order. These
options are found under Order By on the General page of
Preferences.

I cannot attach a file,
shortcut, or web page to
a thought.

Make sure that the thought does not have content. You cannot
attach content to a thought that has content. If the thought has
content, consider moving ‘ extra content’ into Notes.

I clicked an active
thought containing a
web page, and the
browser opened, but the
page doesn’t appear or I
get an error message.

You do not have an open Internet connection. There are two ways
to fix this problem: before you open the web page, open your
Internet connection, or configure your browser to open your
Internet connection automatically when it opens. It is possible that
the web page link is outdated.

Can a thought be a
parent, child, jump,
and sibling at the same
time?

Yes. Any thought can have all these relationships with other
thoughts. However, two thoughts may only have one relationship
with each other at a time.

I know I didn’t delete a
thought, but I can’t see
it.

You probably just ‘forgot’ the thought. Make sure that Forgotten
Thoughts is checked in the Options menu.

How do I back up my
Brain?

To back up your Brain itself, make a copy of the .brn file located in
your My Brains folder. To back up files associated with your Brain,
copy the entire contents of the _brn folder associated with that
Brain.
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What does The Brain
mean when it asks me
to compact it?

If you delete a significant number of thoughts, you will be asked if
you want to compact your Brain. This will save hard disk space.

When I try to open a
thought, a different
application opens or
nothing opens.

You probably have an incorrect file extension attached to the
thought. File extensions follow periods in a file name. Thus, in the
file name letter.doc the extension is .doc. The Brain uses an extension
to identify the file you’ve attached to thoughts. You may have
created a file with an incorrect extension before installing The
Brain.

To change a file’s extension, move the file out of The Brain, open
Windows Explorer, use its renaming mode and then move the file
back into The Brain. To find the correct extension for an
application, check the application’s manual or examine the file
types that have been registered in Windows (open Windows
Explorer, click the View menu, choose Options, and click the tab
marked File Types). Some applications have more than one
extension – it is good practice to use the first one listed. 
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Glossary

activate To send a thought to the center of the plex and make it the active
thought. A thought that is not active can be activated by clicking it,
or its pin, or its name in a list ( past thought, Search, History), or
by entering its name in the instant activation box and pressing
ENTER. See active thought.

active thought The thought you are working on; the center of attention. The active
thought occupies the center of the plex and is surrounded by the
resizing circle. It is the active thought whose details are described
in the Properties tool and whose notes appear in the Notes tool.

application A program such as a word processor, database, web browser,
game, photo editor.

attach A thought may be associated with one file, one shortcut, or one
web page. When such an association exists, the file, shortcut, or
web page is said to be ‘attached’. See content.

auto hide When The Brain window is set to auto hide, it will disappear when
you begin working in another application and will be replaced by
the auto hide button, a small black square with the blue Brain logo
inside. Click the auto hide button to reveal The Brain window, or
attach files by dragging them to the auto hide button, and then into
the plex.

A Brain A collection of associated thoughts, each of which can have
content. The Brain can create multiple Brains.

Brain-Enabled™ A web site that has been mapped for The Brain and provides a
downloadable Brain for you to navigate the site. This
downloadable Brain is called a Site Brain.

child thought A thought with at least one parent. Children of the active thought
appear in the child zone below the active thought. In turn, the
active thought is a child of any thought that appears above it in the
parent zone.

close thought A thought one step (generation) removed from the active thought.
The active thought’s close thoughts appear in the plex with it. See
distant thought.

content A general term for the file, shortcut, or web page attached to a
thought. A file can only have one file, one shortcut, or one web
page attached to it. A thought need not have content. Content is
attached to the active thought by drag and drop or by using the
Select Content dialog box. Existing content must be removed
before new content may be attached.

delete The removal of a thought and its content from a Brain. Deletion is
permanent. 

distant thought A thought two or more steps (generations) removed from the
active thought. Distant thoughts only two generations removed
from the active thought can be displayed in the plex by clicking the
Distant Thoughts option on the General page of Preferences.
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dock The attachment of The Brain window to any of the four edges of
the screen by choosing a Dock entry in the Window menu.

drag and drop Generally, to use drag and drop, select the item you want to drag,
click the mouse button and drag the item to where you want it to
appear.

forget To remove a thought from the plex without deleting it, its links, its
content, or its note. Forgotten thoughts can be ‘remembered’.

gate The active thought and its close thoughts display three circular
‘gates’, each of which can be used to link to specific relations:
lower gate to child thoughts, upper gate to parent thoughts, side
gate to jump thoughts. A gate is hollow when there are no links
through it and solid when links exist.

History The section of the tools window that appears when the History
button is clicked. The History tool lets you search for thoughts
activated, created, or modified within a specified time and lets you
see the relative time spent on the thoughts found.

instant activation
box

Used to activate a thought not visible in the plex window but
whose name you know, the instant activation box is opened by
clicking the rightmost thought in the past thought list; you may
have to scroll right to reach that thought. You can also use the box
to enter the name of, and access, a file, folder, or web page. 

jump thought A jump thought is linked to another thought via its jump (side)
gate and appears in the jump zone to the left of the active thought.
Activating a jump thought produces a more significant
reconfiguration of the plex than activating a child thought or
parent thought. This is because jump thoughts lead to other groups
or family of thoughts.

Guide Brain A Brain containing a collection of web sites. A Guide Brain can be
published and made available to all users. Guide Brains are made
accessible by e-mailing a URL link or placing a button link on a
web site (both are provided by Natrificial). 

link The act of connecting thoughts by dragging from a gate, thereby
establishing close relations. Also, the line connecting two thoughts
in the plex.

Natrificial
Internet Guide

Natrificial’s Guide Brain; displayed in the Brain menu. See Guide
Brain.

navigate To move from thought to thought within a Brain by activating
thoughts in the plex, in the past thought list, in Search and History
lists, and pins.

Notes In addition to content, each thought can have notes. Notes appears
in the tools window when the Notes button is clicked. Notes can
hold any combination of text, images, sound, and shortcuts. Notes
includes a word processor.
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OLE Object Linking and Embedding; a Microsoft standard that allows
images, text, and sound to be moved from one application to
another. Not all applications support OLE.

open Open thought; open thought content; the automatic loading of a
thought’s content (file, web page), achieved by clicking an active
thought which has content, or by using the ‘Open without
Activating’ function.

parent thought A thought that has at least one child. A parent thought is linked to
its child thoughts through its child (lower) gate. The active thought
is a parent of any thought displayed in the child zone, below it.
Parent thoughts of the active thought appear in the parent zone,
above the active thought. 

parentless thought A thought which has no parent thought. A parentless thought is
often a jump thought or a thought which represents a subject
heading or acts as an organizer. Usually, the first thought in a Brain
(generally named after the user) is a parentless thought.

past thought list The scrollable list of thoughts at the bottom of the plex window
arranged in the order activated. The most recently activated
thought is the rightmost thought in the list.

pin A pin is an entry point to a Brain. Click a pin to activate its
thought. A pin is created by dragging a thought to the area
immediately below the menu bar. The pin stays there until it is
removed by being dragged into the menu bar or title bar. You can
also create a pin of the active thought from the Thought menu.

plex The visible portion of your Brain; includes the active thought, its
close relations, and the links between them.

Properties The section of the tools window that appears when the Properties
button is clicked. The Properties tool provides details of the active
thought and its content and lets you rename the active thought.

remember A thought that has been removed from the plex by ‘forgetting’ can
be ‘remembered’ (returned to normal) by dragging a link from it to
any thought in the plex window which is not ‘forgotten’.

Search The section of the tools window that appears when the Search
button is clicked. The Search tool finds and alphabetically lists
thoughts which match specified criteria (Query function), or
thoughts in a particular category.

shortcut A small file and icon that points to a file outside a Brain; a shortcut
allows a file to be opened from the location of the shortcut rather
than the location of the file.

sibling thoughts Two or more thoughts with a common parent. When a thought
which has siblings is active, its siblings are displayed in the sibling
zone, to the right of the active thought.

Site Brain A Brain that contains a map of a Brain-Enabled™ web site. Site
Brains can be published and made available to all Brain users. Site
Brains are made accessible by e-mailing a URL link or placing a
button link on a web site (both are provided by Natrificial).
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spidering The act of automatically converting a web site or part of a web site
into thoughts. To spider a web site, attach the home page of the
desired web site to a thought, click ‘Spider Web Page’ in the
Thought menu, select the desired options, and click Start.

template A file used as the basis for creating other files. Template files can
be added to and removed from the window of the Select Content
dialog box.

thought The basic unit of a Brain. A thought can represent anything the
user wants. A thought can have content in the form of a file,
shortcut, or web page, or it can be ‘contentless’ and simply act as a
subject heading or organizer. A thought has Properties and can
have notes. 

unlink Unlink thoughts you no longer want closely related. When you
unlink thoughts you sever a close relationship. To unlink thoughts,
click the link between them; you will be asked to confirm
unlinking. You cannot unlink a thought’s only link to the active
thought. If you attempt to unlink a thought’s only link to the active
thought, the thought will be highlighted to indicate that the
thought can be forgotten.

URL Universal Resource Locator; the address of a web site.

zones Areas in the plex devoted to specific relations of the active
thought. There are four zones: the parent zone above the active
thought, the child zone below it, the jump zone to its left, and the
sibling zone to its right.
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Index
.brn file 38, 75
_brn folder 38, 75
abandon changes to Notes 45
access privileges 63
activate

forgotten thought 35
activate thought

by clicking it 10
by clicking pin 21
overview 80
via History list 51
via instant activation box 23
via past thought list 22
via Search list 49

active thought 6
active thought indicator 71
add

content 48
template 62

Allow Keyboard Navigation 24, 70
Always on Top 64
Animation 71
application

open from desktop 16
open from Start menu 16

applications
display 64
maximize windows 71
that create files 16, 61
that do not create files 16, 61

ASCII in Notes 44
attach web page

by dragging 15
by naming 15
by selecting content 15

auto hide 5, 29, 64, 77
auto open circle 71
auto open web pages 68
bookmarks 14

Netscape 68
Brain

access privileges 63

and networks 63
compact 79
copy 38
create 26
file 38, 75
folder 38, 75
import 39
instal 2
merge 39
move 38
name 4, 27
new 26
rename 26
save 32
security 63

Brain window 4, 77
always on top 64
auto hide 64
dock 65
float 65
resize 66

Brain-Enabled Web Sites 70
change relationship 34
Check for Brain-Enabled Web Sites 70
child thought 6
child zone 6
clear (Notes) 46
close thoughts 21, 49
Colors 70
command line access 24
compact Brain 79
content

add 11
copy 38
delete 36, 37
Details button 47
icons 13, 69
move 38
open 12
remove 36

copy
Brain 38
content 38
file 38, 74
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file into Brain 14, 74
folder into Brain 14
in Notes 46
shortcut 38
thought 32, 38, 61
web page 38

Count X Minutes of Idle Time ... 71
create

Brain 26
child thought 9
content 11
multiple Brains 63
multiple thoughts 13, 29, 67
pin 22
several thoughts 29
shortcut 12-14, 74
template 62
thought 9, 12, 28
thought by dragging file 12
thought of file 12
thought of web page 15
thoughts by dragging folder 13

CTRL-dragging (copy file) 74
cut in Notes 46
delete

content 36, 37
file 36, 37
pin 22
shortcut 36, 37
thought 36
web page 36, 37

Desktop folder 68
Details button 47
direct web access 24
display

Brain window 64
forgotten thoughts 36, 68
Options menu 67
Thought menu 28

Display Properties 69
Colors 70
Distant Thoughts 69
Font 69
General 69

Icons 69
Markers 69
Order By 69
Reset to Defaults... 69
Siblings 69
Wallpaper 69

distant thoughts 21, 69
dock Brain window 65
drag

file (create shortcut) 74
file to create thought 12
file to thought 12
folder (create thoughts) 13
from web 42
graphic into Notes 42
shortcut into Notes 43
to pin 30
to web page 15

drag and drop 14, 29
dragging 14, 29
Edit menu 46
Explorer 29, 74
Explorer Favorites folder 68
extensions 38, 48, 75, 79
Favorites, Explorer 68
file

copy 38, 74
delete 36, 37
extensions 38, 48, 75
icons 13
import into Brain 75
import into Notes 44
management 74
move 38, 75
move into network folder 63
move out of Brain 63
print 33
save 32
storage in Brain 75
template 62
versions 61

File menu 43
Fill Thought Background 69
Find/Find Next/Replace in Notes 46
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flashing pointer 71
float Brain window 65
folder

create multiple thoughts 13, 67
Desktop 68
Explorer Favorites 68
import 67, 75
My Brains 38
Netscape Bookmarks 68

font 69
forget thought 35
forgotten thought

activate 35
remember 36

forgotten thoughts
display 36, 68

gates 7
generations  49
graphic

import into Notes 42
Help 3
History 50, 63
icons 69
import

Brain 39
file 75
file into Notes 44
folder 67, 75
graphic into Notes 42

insert object in Notes 47
instal The Brain 2
instant activation box 23
Invalid Web Links 49
jump thought 6, 15
jump zone 6
keyboard

commands 76
navigation 70

keywords 48
LAN 63
link

by naming 31
to distant thought 30
to thoughts in plex 29

to thoughts not in plex 30
via past thought list 30
via pin 30

link thoughts 29
links 7, 21, 26, 29
links to object 47
Lou Green’s Brain 7, 77
manage existing files 74
margins in Notes 43
markers 69
Maximize Program Windows 71
menu

Brain 26
Edit 46
File 43
Help 3
Options 67
Thought 27
Window 64

merge Brains 39
Microsoft Windows 74
move

Brain 38
content 38
file into Brain 14, 38, 75
file out of Brain 38, 63
folder into Brain 14, 67
thought 38

multiple Brains on one computer 63
multiple files 61, 67
multiple thoughts 13, 67
multiple users 63
My Brains folder 38
My Documents folder 68
name

Brain 4, 27
thought 9, 47

Natrificial Internet Guide 60
Natrificial thought 27
navigate 21

from keyboard 24, 70
Netscape 42
Netscape Bookmarks folder 68
networks 63
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New Brain 26
Notepad 11
Notes 41

abandon changes 45
clear 46
copy 46
cut 46
drag into 42
Edit menu 46
File menu 43
Find/Find Next/Replace 46
import graphic 42
insert object 47
keyboard commands 76
links to object 47
margins 43
object 47
object properties 47
OLE 42
open application 47
page setup 45
paste 46
print 44
print setup 45
replace text 46
save 42, 44
save copy 44
select all 46
text style 43
undo 46

object
insert 47
links 47
properties 47

Object Linking and Embedding (OLE)
42

online resources 3, 27
open

application from desktop 16
application from Start menu 16
application in Notes 47
Brain 26, 71
content 12
directory 24
file 24

folder 24
thought 11
web page 24, 68, 71
web page automatically 71
without activating 12

Open The Brain on Startup 71
Options menu 67
Order By 69
order of thoughts in plex 69
Page Setup 45
page setup (Notes) 45
parent thought 6
parent zone 6
parentless thoughts 49
past thought list 22
paste (Notes) 46
pin 7, 21

create 22
remove 22

plex 4
resize 66

plex window 7, 66, 77
pointer flashing 71
Preferences 70

Animation 71
General 69
Reset to Defaults... 71
Servers 72

print
file 33
Notes 44
Plex 26

print preview (Notes) 45
print setup (Notes) 45
Private button 48
program files 16
Properties 47

Private button 48
Publishing Brains on Internet 54

Guide Brains 60
in an E-mail Message 56
on a Web Site 56
Removing 56
Site Brains 57
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Updating 56
purchase The Brain 2
Recent (Brains) button 41
Recent Brains 27, 41
Redo in plex window 37, 67
Related Thoughts 49
relationship 17

change 34
remember thought 36
remove

content 36
pin 22
template 62

rename
Brain 26
pin 28
thought 28, 61

replace text in Notes 46
rescale plex 66
resize

Brain window 66
plex 66
plex window 66
tools window 66

resizing circle 66
Rich Text Format (RTF) 44
same-name thoughts 28
Sample Brain 7
save

Brain 32
copy of Notes 44
file 32
graphic in Notes 42
Notes 42, 44
thoughts 32

Save As 32
search engines 67
search thoughts 48
Search tool 48

Find Button 50
Search Web 67
security 63
select all (Notes) 46
Select Content dialog box 11, 14, 48

Servers 72
setup 2
share

Brain 63
computer 63
file 63

SHIFT-dragging (move file) 75
shortcut

copy 38
create 14
delete 36, 37
drag into Notes 43
icons 13
limitations 39
on desktop 16
replace with file 38

Site Brains 57
Spidering a Web Site 57
splitter 66
start Brain 71
Start menu 16
Stop Pointer Flashing 71
store files 75
support 3
system requirements 2
technical support 3
template 32, 62
text style

in Notes 43
in plex (Font) 69

The Wiggle 25
thought

activate 80
activate by clicking 10
animation 71
background 69
categories 48
content 11
copy 32, 38, 61
create 12, 28
delete 36
forget 35
gates 7
generations 49
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keywords 48
move 38
movement 71
name 9, 47
names 28
order in plex 69
properties 47
relationship 17, 34
remember 36
rename 28, 47, 61
same name 28
types 19
zone 6
zones 69

Thought menu 27
thoughts 1, 5

close 21
display distant 69
display forgotten 68
distant 21
forget 35
group 48, 50
link 29
order of in plex 69
remember 36
same name 28
save 32
search 48
unlink 34

tools 40
tools window 40, 66, 77
Troubleshooting 78
undo

in Notes 46
in plex window 37, 67

unlink thoughts 34
update History list 51
versions of file 61
View Published Brains. 26
Wallpaper 69
Wander 67
web page

attach 14
auto open 68

auto open circle 71
copy 38
delete 36, 37
direct access 24
search 67

web sites
Brain-enabled 70

web thought 14
Window menu 64
Windows Explorer 29, 43, 74
Windows, Microsoft 74
word processor (Notes) 43
zones 6, 69
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